1. Introduction

The Epsilon EClipse™ is the latest potentiostat designed by Bioanalytical Systems Inc. to enable scientists to conduct cutting edge electrochemistry experiments in the laboratory. It has upgraded hardware, updated software, an expanded applied potential range, and improved design compared to the Epsilon. This manual is intended to aid the electrochemist in utilizing the Epsilon EClipse™ to its utmost potential.

Additional accessories for electrochemistry experiments using the Epsilon EClipse™ are available from BASi. These include the C3 cell stand, the controlled growth mercury electrode (CGME), and a rotating disk electrode (RDE2). These are mentioned where appropriate throughout the manual.

Specifications:

**Potentiostat:**
- Channel 1 applied potential: Dynamic DAC: 16 bit, ±3.275 V at 0.1 mV resolution or ±10 V at 0.33 mV resolution
- Offset DAC: 8 bit, ±2.55 V at 10 mV resolution
- Channel 2 applied potential: Dynamic DAC: 8 bit, ±2.55 V at 10 mV resolution
- Compliance voltage: ±12 V
- Maximum current: 100 mA
- Bandwidth: >10^12 W
  (values for parameters other than applied potential are for both channels)

**Current to voltage converter:**
- Full scale sensitivity: 1 nA*, 10 nA*, 100 nA, 1 µA, 10 µA, 100 µA, 1 mA, 10 mA, 100 mA
  (*secondary gain used)
- Secondary gain: x1, x10, and x100
- ADC resolution: 16 bit
- Sampling rate: 50 kHz (20 µs/conversion)
- Data length: ≤ 64,000 points – fast

**Galvanostat:**
- Applied current: 50 pA – 50 mA
- Voltage range: ±10 V or ±1 V
- Measured voltage resolution: 0.02 mV
- Maximum leakage current: 30 pA

**Minimum PC requirements:**
- Windows 7 or higher
- Pentium III
- 512 MB RAM
- 50 MB hard drive space available
- USB port

**Power requirements:**
- 120 or 240 V AC, 50/60 Hz, 60 VA

**Dimensions & Weight:**
- 15.75” (40 cm) x 5.25” (13 cm) x 12.75” (32.5 cm)
- 17.5 lbs (7.4 kg) for single channel potentiostat
2. Safety Precautions

The following general safety precautions must be observed during all phases of operation, service, and repair of this instrument. Failure to comply with these precautions or with specific WARNINGS, CAUTIONS, or NOTES elsewhere in this manual may impair the protection provided by the equipment. Such noncompliance would also violate safety standards of design, manufacture, and intended use of the instrument.

Bioanalytical Systems, Inc. assumes no liability for the customer’s failure to comply with these requirements.

- For indoor use only.
- Ground the Instrument. To avoid electric shock, the instrument must be grounded with the supplied power cable’s grounding prong.
- DO NOT exceed the operating input power, voltage, current level and signal type appropriate for the instrument. Refer to the Installation Section for further information.
- Electrostatic discharge (ESD) can damage the highly sensitive microcircuits in your instrument. ESD damage is most likely to occur as the instruments are being connected or disconnected. Ground yourself to discharge any static charge built-up by touching the outer shell of any grounded instrument chassis before the I/O connectors are connected or disconnected.
- DO NOT place the instrument in fluid or expose the internal elements or back panel to fluid.
- DO NOT Operate in an Explosive Atmosphere. Do not operate the instrument in the presence of inflammable gasses or fumes. Operation of any electrical instrument in such an environment clearly constitutes a safety hazard.
- Keep Away from Live Circuits. Operators must not remove instrument covers. Component replacement and internal adjustments must be made by qualified maintenance personnel. Do not replace components with the power cable connected. Under certain conditions, dangerous voltage levels may exist even with the power cable removed. To avoid injuries, always disconnect the power and discharge circuits before touching them.
- DO NOT Substitute Parts or Modify the Instrument. To avoid the danger of introducing additional hazards, do not install substitute parts or perform unauthorized modifications to the instrument. Return the instrument to Bioanalytical Systems, Inc. Service Department for service and repair to ensure that safety features are maintained in operational condition.

If you notice any unusual conditions as listed below, immediately terminate operation and disconnect the power cable. Contact the Bioanalytical Systems, Inc. Service Department for repair of the instrument. If you continue to operate without repairing the instrument, there is a potential for hazard or damage to both the equipment and the operator.

- Instrument operates abnormally
- Instrument emits abnormal noise, smell, smoke or a spark-like light during operation
- Instrument generates high temperatures or electrical shock during operation
- Power cable, plug or receptacle on instrument is damaged
- Foreign substance or liquid has penetrated the outer cover of the instrument
Throughout the course of this manual, the following will be used to designate important information:

**WARNING** – This signifies extreme hazard. Not following the instructions may result in serious injury or death.

**CAUTION** – Following information relates to a hazard. If instructions are not followed properly, it can result in irrevocable damage to the instrument.

**NOTE** – This implies that the following instructions are essential for the user to understand in order to operate the equipment effectively.

### Symbols

- **Caution:** Risk of Danger. User’s Manual must be consulted in all cases where this symbol is marked.

- Alternating current

- Fuse

- On (Supply)

- Off (Supply)

- Complies with European Union Directives

- The European Waste Electrical and Electronic Equipment (WEEE) Directive
3. Installation

Connections to the cell and the cell stands (C3, RDE-2, CGME) are made on the front panel of the Epsilon EClipse™ system. All other connections, including the power and USB port, are made on the rear panel.

3.1. Power

The Epsilon EClipse™ system requires a grounded power supply, providing either 120VAC at 60Hz or 240VAC at 50Hz. Before connecting the supplied power cord, check that the indicator next to the power connection shows the correct voltage.

If you need to change the power input for any reason, please contact BASi for assistance.
3.2. Computer

The Epsilon EClipse™ system requires a computer with at least 512 MB RAM, 50 MB available hard drive space running Windows 7 or later. Connect a standard USB cable between any USB port on the computer and the USB port on the back of the Epsilon EClipse™.

The Epsilon EClipse software is included on a CD with each purchase. The most updated version can be downloaded from the BASi website: http://www.basinc.com.

3.3. Cell Connection

The cell connection on the Epsilon EClipse™ can be found on the lower front panel of the instrument. The cell lead cable is the group of wires that connects the Epsilon EClipse™ to the electrodes of the electrochemical cell. The Epsilon EClipse™ has been supplied with a single-channel cell lead cable or a dual-channel cell lead cable, depending on whether it is a standard potentiostat or a bipotentiostat.

**WARNING:** NEVER CONNECT OR ADJUST THE CELL LEADS DURING AN EXPERIMENT OR WHEN THE CELL IS ON. DOING SO COULD DAMAGE THE SENSITIVE AMPLIFIERS AND VOID YOUR WARRANTY.

The general purpose cell lead cable is terminated with alligator clips that attach directly to the cell electrodes.

<table>
<thead>
<tr>
<th>Single-channel cell lead (ER-9861)</th>
<th>Bipot cell lead (ER-9860)</th>
<th>Cell Stand cable (ER-9862)</th>
</tr>
</thead>
<tbody>
<tr>
<td>There are 3 electrode leads and 1 grounded (shielding) lead.</td>
<td>There are 4 electrode leads and 1 grounded (shielding) lead.</td>
<td>This cable is available for direct attachment to the LEMO port on a BASi cell stand.</td>
</tr>
<tr>
<td>Black: Working Electrode</td>
<td>Black W1: Working Electrode W1</td>
<td></td>
</tr>
<tr>
<td>Red: Auxiliary electrode</td>
<td>Black W1: Working Electrode W2</td>
<td></td>
</tr>
<tr>
<td>White: Reference electrode</td>
<td>Red: Auxiliary electrode</td>
<td></td>
</tr>
<tr>
<td>Ring: Ground connector</td>
<td>White: Reference electrode</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Ring: Ground connector</td>
<td></td>
</tr>
</tbody>
</table>
3.4. Analog Input/Output

Analog inputs and outputs can only be used for potentiostatic techniques. An analog output is provided for the W1 and W2 channels (W3 and W4 are unavailable on the Epsilon EClipt™), and must be activated from within the software (see Manual Control in section 7.2). These outputs have a full scale output of ± 10 V and are provided for connection to chart recorders and other data-acquisition devices. The W1 or W2 terminal should be connected to the “high” or “+” input of the peripheral device, and the GND terminal to the "low" or "-" input (do not use any additional grounding that may be available on the peripheral device).

The E OUT output is provided to monitor the potential applied to the cell on W1 (or the potential of the working electrode in the Open Circuit Potential technique), and the E IN input is provided to apply a potential to W1 from an external source (this external potential is summed to the potential applied by the Epsilon EClipt™). Please be aware that noise may be introduced into the system when E IN is activated.

3.5. Remote Start/Stop

The remote start and stop connections provide several alternatives for sending and receiving signals to and from other instruments. These functions are fixed in time and cannot be modified. For programmable triggers to remote instruments, see Timed Events below.

START IN

Allows an external device to trigger the start of an experiment. Note that this is not the start of data acquisitions, and several hundred milliseconds plus the Quiet Time may elapse from the trigger until data acquisition starts. A switch closure or TTL-low of at least 55ms across the START IN terminal and its ground will trigger the run.

START OUT

Used to trigger other instruments at the start of an experiment. It provides a 1 second TTL-low.
STOP IN

Not applicable for the Epsilon EClipse™.

STOP OUT

Used to trigger other instruments at the end of an experiment. It provides a 1 second TTL-low at the end of the run. The time between the last data point acquired and this signal depends upon the technique and its parameters.

3.6. Timed Events

Timed Events are programmable switch closures that provide exceptional flexibility for controlling peripheral instruments. Four switches are provided, which can be connected in a normally-open (NO) or a normally-closed (NC) configuration. Two possible configurations to create TTL signals are shown below.

With both configurations the trigger line will normally be at 5V and will step to 0V when activated. In the figure on the right, the resistor (1 - 10kΩ) is required to limit the current drawn from the 5V power supply. These switches may be manually activated in the software, or programmed as part of Sequential Techniques (see section 7.4 and section 7.6).

3.7. Starting the Epsilon EClipse™

Once the Epsilon EClipse™ is plugged into the USB port on your computer and powered on, you can open the Epsilon EClipse™ software. The software will automatically connect to the instrument. You should see the message “Epsilon Connected” in the bottom left corner of the software. If you receive the following message when you open the software, please check the power and USB connections.
If the connection is broken after it has been established, the PC and the Epsilon EClipse™ can be reconnected using **Reconnect Epsilon** in the **Instrument** menu.
4. Epsilon EClipse™ Chemical Test Procedure

**Purpose**

The purpose of this test is to perform a final examination of the Epsilon EClipse™ before going to the customer, and to provide the customer with typical output and data. From these outputs, the customer can verify that the instrument is working properly on arrival and can gain some experience in its operation.

**Instrument Installation**

Please follow the installation instructions at the beginning of this manual. If available, a BASi cell stand should be connected to the **CELL STAND** port on the front of the Epsilon EClipse™.

**Test Solution**

2 mM potassium ferricyanide with 1 M potassium nitrate in water.

**Preparation of the Test Solution**

1. Weigh 16.5 mg potassium ferricyanide and place in a 25 mL volumetric flask.
2. Weigh 2.53 g potassium nitrate and add to the same volumetric flask.
3. Add about 20 mL deionized water to dissolve the potassium ferricyanide and potassium nitrate.
4. Dilute to 25 mL with deionized water.

**Cell (C3 Cell Stand)**

Platinum (PTE) Working Electrode (Black lead)
Platinum Wire Auxiliary Electrode (Red lead)
Silver/Silver Chloride RE-5B Reference Electrode (White lead)

Add 10-15 mL of the ferricyanide solution to the cell vial and place in the cell holder (see Cell Stand instructions). Polish the PTE with 0.05 µm alumina following the polishing instructions provided in the polishing kit.

If the RE-5B electrode is new, carefully remove the yellow plastic sheath before use. In addition, there may be air bubbles inside the electrode next to the CoralPor™ frit; these must be displaced (by flicking the electrode). RE-5B electrodes must be stored in 3M sodium chloride when not in use.

**Procedure**

1. Turn the Power switch on the Epsilon EClipse™ to on.
2. Open the Epsilon EClipse™ software by clicking the **EpsilonEC** icon. The software will automatically connect to the instrument. You should see the message “Epsilon Connected” in the bottom left corner of the software. If you receive a message that the software is unable to
connect to the instrument, please check the power and USB connections. If the link is lost after being established, use **Reconnect Epsilon** in the **Instrument** menu to reestablish the link.

3. Click **New** in the **File** menu to set up a new experiment. The list of available techniques is displayed (Fig 1). It should be noted that there are some techniques that are labeled as **DEMO**. This label indicates that this technique is **NOT** active on this particular Epsilon EClipse™. However, it is possible to load a data file for that technique to examine the parameters and the typical output. If the **RUN** button is clicked when a DEMO data file is displayed in the active window, an error message will be shown. The technique list shown in **Figure 1** is the list for the Basic-Plus and Methods Epsilon EClipse™ software.

![Figure 1 – Selecting a New Technique](image)

4. Select **Cyclic Voltammetry**. The new **.etech** file can now be edited. Enter the values shown in **Figure 2**. Note that **Switching Potential 2** is not required since there are only 2 segments (**Initial Potential to Switching Potential 1 to Final Potential**). Various experimental data can be entered into the **Experimental Conditions** section. These notes will also be saved when the experimental data is saved. Once these changes have been entered, an experiment using these parameters can be run by clicking the **RUN** button. An experiment can be run using either **Run** in the **Experiment** menu, or the **RUN** icon on the Tool Bar. This icon will change to **STOP** during the experiment, and can be used to abort the experiment.
5. After the experiment has been run, the voltammogram will be displayed (Figure 3). Note the information about the experiment and the peak parameters on the right side of the graph.

6. A specific area of the graphic can be enlarged by using the mouse cursor (and the left mouse button) to define the area (Figure 4), by using the mouse scroll to zoom in and out, or by entering the x and y values in the Data Display Settings dialog box in the Graph menu (Figure 5). The original graph can be restored using Zoom Full Range in the Graph menu.
Figure 4 - Enlarged section of the Cyclic Voltammetry graph

Figure 5 - Data display settings dialog box

7. Use **Save** in the **File** menu to save the data in the active .edata window. The data can be converted to a number of different text formats using **Save Data As** in the **File** menu (**Figure 6**). Select the desired options and the delimiter, and then click **OK** to save the converted Data.
8. Click on the open .etech window. To the right of the graph, find the scan rate parameter box and change the **Scan Rate** to 200 mV/s. Run the experiment again. Note that the new data is displayed in a new .edata window. Save this data. Change the scan rate to 500 mV/s, run the experiment, and save the data.

9. The three data sets run at different scan rates can be displayed on the same sets of axes using the **File Overlay** function in the **Graph** menu. All open *.edata files will be added to the overlay (Figure 7).

![Figure 6 - File conversion](image)

![Figure 7 - Overlayed cyclic voltammograms](image)
10. Click **New** in the **File** menu, and select **Cyclic Voltammetry** again. Enter the parameters shown in **Figure 8**, and run this experiment. Since there are 3 segments, 4 potential parameters must be defined (**Initial Potential**-**Switching Potential 1**-**Switching Potential 2**-**Final Potential**).

**Figure 8** - **New Cyclic Voltammetry Parameters**

11. Click **New**, and select **Chronoamperometry/Chronocoulometry** from the list of techniques. A third window will appear. Enter the parameters shown in **Figure 9**. Running the experiment generates the plot shown in **Figure 10**.

**Figure 9** - **Parameters for Chronoamperometry/Chronocoulometry**
12. The data from a Chronoamperometry/Chronocoulometry experiment can be plotted in a number of different formats, which can be selected using Select Graph Type in the graph menu, or by right-clicking on the graph. The Q vs. sqrt(T) plot is shown in Figure 11.

13. The Epsilon ECclipse™ software can calculate the slope and intercept of the linear Q vs sqrt(T) plot when it is displayed. Selecting Calculate CA-SIR from the Analysis menu generates the information box shown in Figure 12. The lines used for the linear fitting are the dashed blue lines in Figure 12 (note that the first 20% of the data points are not used in the calculation, due to interference from the charging current and other experimental artifacts).
14. Click New, and select Chronopotentiometry. A fourth experiment window will be opened. Enter the parameters shown in Figure 13, then run the experiment (note the sign convention for the current - cathodic (reduction) currents are positive for polarographic). Typical data for a Chronopotentiometry experiment is shown in Figure 14.
15. Click **New**, and select **Square Wave Voltammetry** (note that this requires the optional Basic Plus software). A fifth experiment window will be opened. Enter the parameters shown in **Figure 15**, then run the experiment. Typical data for a **Square Wave Voltammetry** experiment is shown in **Figure 16**.
16. The default plot for a Square Wave Voltammetry experiment is the difference current; that is, the current on the forward cycle less the current on the reverse cycle. The forward and reverse currents are also available by right-clicking on the graph, or by selecting Select Graph Type from the Graph menu. The forward current data set is shown in Figure 17.

This completes the chemical test. All printed output should be shipped with the instrument. The power cord and cell lead (with alligator clips on the cell end) are shipped with the Epsilon EClipse™.

Copyright © 2016 Bioanalytical Systems, Inc.
5. Interfacing BASi Accessories with the Epsilon EClipse™

5.1. Cell Stand (C3 and CGME)

Various operations of the BASi cell stands (purge, stir, and knock/dispense) can be controlled from the Epsilon EClipse™.

1. Connect the Cell Stand (C3 or CGME) to the Epsilon EClipse™ using the 25-pin ribbon cable provided with the Cell Stand between the CELL STAND port on the front panel of the Epsilon EClipse™ and the REMOTE port of the cell stand.
2. Connect the DIN-LEMO cable (ER-9862) between the CELL port on the front panel of the Epsilon EClipse™ and the CELL port on the rear panel of the Cell Stand.
3. For instructions on using the C3 and CGME cell stand capabilities within the software, please see section 7.2 and section 7.4.

5.2. RDE-2 Rotating Disk Electrode

The rotation and purging functions of the RDE-2 Rotating Disk Electrode can be controlled from the Epsilon EClipse™.

1. Connect the RDE-2 to the Epsilon EClipse™ using the 37-pin ribbon cable provided with the RDE-2 between the ACCESSORIES port on the front panel of the Epsilon EClipse™ and the ACCESSORIES port on the rear panel of the RDE-2.
2. Connect the DIN-LEMO cable (ER-9862) between the CELL port on the front panel of the Epsilon EClipse™ and the CELL port on the rear panel of the RDE-2.
3. For instructions on using the RDE-2 capabilities within the software, please see section 7.2 and section 7.4.
6. Upgrading the Epsilon ECliptse™

Please contact BASi if you wish to upgrade your techniques package, or if you wish to upgrade your single-channel instrument to a bipotentiostat.

More information can be found on the BASi website: 
7. Epsilon EClipse™ Software

Introduction

A detailed description of the available electrochemical techniques and how to perform them using the electrochemistry software are provided. These functions can all be accessed from the drop-down menus in the software. Some of the functions are also available as icons on the tool bar. The available routes will be noted in the appropriate sections. If you are new to the instrument, we recommend conducting the chemical test, a detailed step by step guide to an example electrochemistry experiment, after installation to familiarize oneself with the basic functions of the Epsilon EClipse™ software.

General Overview

The Epsilon EClipse™ software runs in the Windows operating system. It is compatible with Microsoft Windows 7 and above. It is important to note there are a number of different configurations for the Epsilon EClipse™, which differ in their capabilities. It is clearly shown in the text of this manual whether a function or electrochemical technique is included as standard on Epsilon EClipse™ instrument, or whether it is only available as an optional addition. All optional additions that are inaccessible will be labeled DEMO.

Starting the Software

After installing the software, it can be opened by double-clicking on the icon on the desktop. The software should automatically connect with the instrument. If it fails to connect automatically or the connection is lost, select reconnect epsilon in the instrument menu.

7.2. Instrument Menu

The Instrument menu allows various settings and controls to be changed on the connected Epsilon EClipse™. Some of these options are only available while a technique is open.

Measure Open Circuit Potential

This menu option allows a continuously updating measurement of the open circuit potential at the W1 electrode. Please be aware that the cell is on during this measurement and should not be disconnected or adjusted until the measurement is terminated by clicking the Done button.

Measure IR Compensation

This menu option is only available while an applicable technique is open. This measurement is not applicable for galvanostatic, open circuit potential, or multi-channel techniques. If the menu option is grayed out, click the mouse in the graphing portion of the open technique window to activate the command.

Selecting this menu option will activate the IR Comp Measurement section of the open technique. Please be aware that the cell is on during this measurement and should not be disconnected or adjusted until the measurement is complete. Before selecting this menu item, you have the option to change the Test Potential (mV) in the technique parameters.
Reconnect Epsilon

If at any time the Epsilon EClipse™ becomes unconnected, you can use this menu option to reconnect the instrument.

Setup

**Line Frequency**

This selects the frequency of the line supply, which is used to calculate the time required for one of the current sampling options in pulse and square wave experiments. Measuring the current over one line cycle is important for noise minimization.

**Default Display Type**

This selects the default display type, Polarographic or IUPAC. See **section 7.8** for more information.

**Cell Stands/Accessories**

The correct option must be selected to control the various Cell Stand operations from the software (i.e., purge and stir for the C3; purge, stir, and knock/dispense for the CGME; and purge and rotate for the RDE-2). Before the cell stand can be selected, the Cell Stand must be switched on and connect to the Epsilon EClipse™ as described in **section 5**.
Manual Control

Purge/Stir/RDE-2

The purging and stirring functions of BASi Cell Stands can be switched on and off from this dialog box. If one of these functions is enabled, the time for which this function is active must also be entered. The Stop button is used to stop this function before the specified time. The appropriate Cell Stand from Cell Stand/Accessories (see above Setup information) must be selected in order to ensure proper activation of these functions. In the case of the RDE-2, the time entered in the Stir/Rotate field refers to rotation of the electrode.

Back Panel Event On/Off

These activate the back-panel Timed Event relays (see section 3).

Current Cell Status

This option specified whether the electrochemical cell is actively connected (Cell On is checked) to the instrument at that moment. The default condition is that it is disconnected (Cell On is not checked). This is the safest option, since manipulation of the cell lead connections while the cell is connected can cause harm to the user and severe damage to the instrument. If Cell On is checked, the potential applied to the cell must also be specified (@ Potential (mV)). The potential may be applied in either of the two ranges the instrument is capable of producing, ±3.257V or ±10V. The Current Cell Status will be maintained until an experiment is run. During an experiment, the cell is obviously connected; the cell connection at the end of the experiment is defined in the technique parameters (see section 7.4).

External E and I

These activate the back-panel Timed Event relays (see section 3).
7.3. Selecting a Technique

A number of different electrochemical techniques are available in the Epsilon EClipse™ software, depending upon the version. For example, the most basic version has cyclic voltammetry (CV), linear sweep voltammetry (LSV), chronoamperometry (CA), controlled potential electrolysis (CPE), DC potential amperometry (DCPA), open circuit potential vs. time (OP), and chronopotentiometry (CP). The basic plus version of the software includes sampled current polarography (SCP), normal pulse voltammetry (NP), differential pule voltammetry (DPV), square wave voltammetry (SWV), and stripping voltammetry. The methods software enables the preparation of sequential techniques. An unlimited number of techniques can be prepared sequentially. These techniques have different applications, which will be discussed in detail in other sections. There are two ways to select a technique:

Open

Selecting Open from the File menu will generate a standard Windows file dialog box, from which a previously saved technique file can be loaded. Techniques created in the Epsilon EClipse™ software will have the .etech extension. Legacy technique files (created in the old Epsilon software) can also be opened. You have the option to select the specific file type extension, or you can view all file types. Other possible file type extensions for the Epsilon EClipse™ software include .edata for data and .eseq for sequences.

Opening a File

When opening a file, all stored technique parameters are available on the right side of the graph (Fig2). Upon opening a legacy file, the experimental data is displayed. The technique windows can be dragged to a different position within the main window. Multiple windows can be tiled vertically, horizontally, or cascaded using the appropriate options in the Window menu.
Opened Experimental Window
All files can also be selected from any folder on the computer and dragged into the software window. This allows for instant opening of many files.

New
Selecting **New** from the **File** menu or the **New** icon will generate a menu that lists the available techniques. Select the desired technique and the technique parameter window will appear.
A new technique can be opened by selecting **New** in the **File** menu. It should be noted that there are some techniques that are labeled as DEMO. This label indicates that this technique is NOT active on this particular Epsilon EClipse ™. However, it is possible to load a data file for that technique to examine the parameters and the typical output. If the **RUN** button is clicked when a DEMO data file is displayed in the active window, an error message will be shown. Highlight the required technique, and click **OK** to confirm the selection.

A previously saved technique can be opened by selecting **Open** in the **File** menu. All previously saved techniques will have the .etech file extension. If a second file is initiated, the data for this experiment is displayed in a separate window. The experimental windows can be dragged to a different position within the main window. Multiple windows can be tiled vertically, horizontally, or cascaded using the appropriate options in the **Window** menu.

### 7.4. Editing Techniques

#### Cell Settings

**Cell Selection**

This function allows the user to select between the external **W1 Cell Lead** connection (required for running an experiment on an electrochemical cell) or an internal dummy cell (for troubleshooting). Two choices are available for the internal dummy cell – a $10k\Omega$ or a $10M\Omega$ resistor. When the **C3 Cell Stand**, **CGME SDME Mode**, or **RDE-2 are selected**, the external **W1 Cell Lead** is also active by default.

Note that the internal dummy cells options are not available for Controlled Potential Electrolysis (CPE), Chronopotentiometry (CP), or Double Step Chronopotentiometry (DSCP).

**CGME SDME Mode**

This option is available when the **Cell Selection** is set to **CGME SDME Mode**. This mode should be used with the BASi CGME cell stand for polarography and stripping experiments. It can also be used with voltammetry experiments using a single mercury drop for the entire experiment. Both the number of drops before the experiment (**Pre Run Drops**) and the drop knock operation (**Knock**) can be specified in this section. For most potentiostatic experiments, the **Pre Run Drops** are formed with the cell on at the **Initial Potential** (for stripping experiments, they are formed at the **Deposition Potential**).

Note that the **Pre Run Drops** are not available for Controlled Potential Electrolysis (CPE).

**RDE-2 Settings**

This option is available when the **Cell Selection** is set to **RDE-2**. This mode is used to Enable Rotation during the technique at the specified RPM (0 or 50-10,000). This mode can also be used with stripping voltammetry experiments.

#### Experimental Conditions

This section of the technique allows the user to enter a number of useful parameters to describe the electrochemical cell (e.g. solvent, electrodes, etc.). This information is saved along with the data and other experimental parameters.
For convenience, the large assortment of BASi electrodes can be chosen from a list and will automatically populate the applicable electrode information.

**Deposition**

These parameters are only available for stripping voltammetry techniques (LSSV, SWSV, and DPSV). Please find more detailed information on these parameters in section 7.5.

**Start Conditions**

This parameter determines how the technique starts. If the **Immediate** option is selected, the technique will begin as soon as the user runs the technique through the software. If **External Input** is selected, the experiment is started from an external device using the **Start In** back-panel connection (see section 3).

Some techniques (CV, LSV, CA, MCCV, MCCA, and all pulse techniques) have the option to specify whether **Initial E = Open Circuit Potential**. If this parameter is enabled, then the open circuit potential will automatically be measured and used as the initial potential. These techniques, plus all stripping techniques, also allow a **Quiet Time (s)** to be set. When the experiment is started, this causes the cell to be held at the initial potential for the number of seconds defined by this field.

**Technique Parameters**

The options available in the Technique Parameters section will vary based on which technique is selected. Some of the common parameters are discussed in the following section. For more detailed information on technique-specific parameters, please see section 7.5.

**Applied Potential**

For most techniques, the W1 Applied Potential can be set within two ranges: ±3,275mV or ±10,000mV. The amount and variety of applied potential settings will vary based on which technique is selected.

For bipotentiostat techniques, the W2 Applied Potential is limited to the range ±2,550mV.

Please note that when using the Epsilon EClipse™ software on older Epsilon instruments, the ±10,000mV range will not be available.

For some of the techniques, the applied waveform will be shown in the graph to the left of the Technique Parameters. This allows for confirmation that the parameters entered generate the expected waveform.

**Scan Rate**

The **Scan Rate** parameter defines the rate of the applied sweep potential for CV, LSV, and MCCV techniques. The digital waveform generator approximates a linear waveform with a staircase waveform with 100μV steps (with ±3.275V range) or 1/3mV steps (with ±10V range). Since the waveform is generated digitally, only discrete scan rates are allowed. The allowable scan rates are given by the equations

\[
\pm 3.275 V \text{ Scan Rate } \left( \frac{mV}{s} \right) = \frac{100,000}{n} \quad \pm 10 V \text{ Scan Rate } \left( \frac{mV}{s} \right) = \frac{1,000,000}{3n}
\]
where \( n \) is an integer. Thus, if a scan rate is entered that does not match the allowed values, the software will automatically change it to the nearest allowed value. The maximum scan rate allowed is 10,000mV/s.

**Current Range**

There are two gain stages for the current-to-voltage converter. The default values of these stages that are used for a given **Full Scale Current (+/−)** are determined by the software. However, they can be adjusted manually using the **Current Range Stage 1** and **Current Gain Stage 2** parameters.

When set manually, the two gain stages for the current-to-voltage converter control the **Full Scale Current (+/−)**. The first stage has values in decades from 100nA to 10mA, whereas the second stage is a multiplier with values of 1, 0.1, and 0.01; that is, the lowest full scale is 1nA. There is more than one combination for intermediate values of the full scale, and the default values selected by the software are suitable for most applications.

**Noise Filter**

Analog filtering is used to remove noise from the experimental data. The filtering in the Epsilon EClipse™ consists of a two-pole Bessel filter. The amount of filtering (the cut-off frequency of the filter) must be selected with care, since overfiltering can distort the experimental data. The correct filter frequency depends on the time scale of the experiment, and is selected by the software to be at least 10 times larger than the time scale of the electrochemical experiment. Although an alternative filter can be selected manually, it is generally best to use the default filter.

**Number of Runs**

With the exception of galvanostatic and Open Circuit Potential techniques, a technique can automatically run the identical experiment repeatedly for a specified number of times. The number of times to repeat is entered in the **Number of Runs** field.

When **Number of Runs** is greater than 1, the **End Cell State** section will contain additional fields. The time between experiments is defined through **Delay Between Runs (s)** (2-3600s). Purging and/or stirring will be activated between the experiments if **Purge During Delay** and/or **Stir During Delay** are enabled.

All data collected during the multi-runs can be displayed and saved in a single data file. To view data from each individual run, double-click on the left or right sides of the graph to cycle through the data.

**iR Compensation**

For a detailed description of iR Compensation and when it should be used, please see Appendix B. Please note that iR Compensation is not available for galvanostatic techniques, open circuit potential, or multi-channel techniques.

**Run Technique with iR Comp**

Enables or disables iR Compensation while the technique is running.
**Select IR Comp Run Parameters**

The simplest way to use iR Compensation is to enter **User Assigned Parameters**. However, if the user prefers, the software will use the instrument to automatically calculate the compensation (see more information below). If **User Assigned Parameters** is selected, values should be entered for **Compensated Resistance** ($0-100k\,\Omega$) and **Stabilization Capacitor** (None, Small, or Large).

**IR Comp Measurement**

When **System Measured Parameters** is selected from the **Select IR Comp Run Parameters** drop-down box, the user must enter a value for the **Test Potential** (note that this should be a value at which there is no faradaic reaction).

Select **Measure IR Compensation** from the **Instrument** menu to begin the measurement. The following results will be filled out under **System Measured Parameters** upon completion:

- **Total Resistance** ($\Omega$) calculated by the system
- **RC Time Constant** ($\mu$s) of the cell
- **Uncompensated Resistance** ($\Omega$) remaining after compensation
- **Compensation** (%) percentage to be used in positive feedback

Make sure that **Run Technique with IR Comp** is set to **Enabled** to run the experiment with these measured values.

**End Cell State**

These options specify whether the electrochemical cell remains actively connected at the end of an experiment, and, if so, at what potential. The default condition is **Cell Off** (i.e. the electrochemical cell is not actively connected). If the cell is to remain actively connected, the applied potential can be the initial potential (**Cell On @ Initial Potential**) or the final potential (**Cell On @ Final Potential**) of the experiment. It can also remain actively connected at a user-specified potential (**Cell On @ Specified Potential**) according to the value entered in **Specified Potential** (mV).

**WARNING:** **CAUTION SHOULD BE USED IF ANY OF THE CELL ON OPTIONS ARE USED, SINCE CONNECTING OR DISCONNECTING THE ELECTRODES WHEN THE CELL IS ON CAN RESULT IN DAMAGE TO THE POTENTIOSTAT, THE CELL, AND/OR THE USER!**

Please note that the End Cell State parameters are not available for galvanostatic techniques or open circuit potential.

When the **Number of Runs** is set to a value greater than 1, this section of the parameters will contain additional fields for setting the **Delay Between Runs** (s), **Stir During Delay**, and **Purge During Delay**.
7.5. Available Techniques

Basic Techniques

Cyclic Voltammetry (CV)

Cyclic Voltammetry (CV) is one of the most commonly used electrochemical techniques, and is based on a linear potential waveform; that is, the potential is changed as a linear function of time.

See the figure above for an example CV waveform. The potential range is scanned starting at the Initial Potential. At Switching Potential 1, the potential range is scanned again in the reverse direction. The experiment can be stopped at the Final Potential, or the potential can be scanned past this potential to Switching Potential 2, where the direction of the potential scan is again reversed. The potential can be cycled between the two switching potentials for several cycles before the experiment is ended at the Final Potential. (The practical limit on the number of segments is based on the maximum 64,000 data points that can be collected during an experiment.) The Scan Rate defines the rate of change of the potential with time.

Range of allowed parameter values:

- Potential: ±3275mV or ±10V
- Scan Rate: 1-25000mV/s
- Quiet Time: 0-100s

The defined waveform will depend upon the number of segments:

- 1 segment: Initial Potential → Final Potential (equivalent to an LSV experiment)
- 2 segments: Initial Potential → Switching Potential 1 → Final Potential
- 3 segments: Initial Potential → Switching Potential 1 → Switching Potential 2 → Final Potential (setting Final Potential equal to Initial Potential will generate a complete potential cycle)
• 4 segments: Initial Potential → Switching Potential 1 → Switching Potential 2 → Switching Potential 1 → Final Potential

Additional segments can be added beyond 4, but those segments will be repetitions of those four settings.

The default plot for CV is the current vs. potential plot \( (I \text{ vs } E) \). Other plot types can be selected by right-clicking on the resultant data and selecting \( I \text{ vs } t \) (current vs. time), \( E \text{ vs } t \) (potential vs. time, i.e. the applied waveform), and the derived graphs Semi Int and Semi Diff.

For information on CV and LSV analysis, please see the Appendix C.

**Linear Sweep Voltammetry (LSV)**

Linear Sweep Voltammetry (LSV) is a simplified form of CV. This technique is equivalent to a CV technique consisting of a single segment. For LSV, only the Initial Potential, Final Potential, and Scan Rate are required to build the applied waveform.

**Chronoamperometry/Chronocoulometry (CA)**

Chronoamperometry (CA) and Chronocoulometry (CC) have the same potential waveform – the potential step – which is one of the simplest potential wave forms.

See the figure above for an example waveform. The potential is changed instantaneously from the Initial Potential to the First Step Potential, and it is held at this value for the First Step Time. This is a single potential step experiment. In a double potential step experiment, the potential is changed to the Second Step Potential after the First Step Time, and it is then held at this value for the Second Step Time. In CA, the current is monitored as a function of time, whereas in CC, the charge is monitored as a function of time. It is important to note that the basic potential step experiment on the Epsilon EClipse™ is CA; that is, during the experiment, the current is recorded as a function of time. However, after the experiment, the data can also be displayed as charge as a function of time (the charge is calculated by integrating the current). Hence, chronocoulometry data can be obtained.
CA is different from other constant potential techniques (such as CPE and DCPA) in that the time scale of CA is shorter (milliseconds and seconds) than those of CPE and DCPA (seconds and minutes).

Range of allowed parameter values:

- Potential: $\pm 3275\text{mV or } \pm 10\text{V}$
- Quiet Time: 0-100s
- Step Time: 1-65s or 1-16000ms
- Maximum # of points in a step: 1000, 2000, 4000, 8000, 16000

The Sample Interval is determined by those parameters, and can only be adjusted by the user indirectly. The relationship between these parameters is shown by the equation

$$\text{Sample Interval} = \frac{\text{Step Time}}{\text{Maximum # of Points}}$$

However, it should be noted that only certain values are allowed for each of these parameters, as is shown in the table below:

<table>
<thead>
<tr>
<th>Maximum # of Points</th>
<th>1000</th>
<th>2000</th>
<th>4000</th>
<th>8000</th>
<th>16000</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample Interval</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>20µs</td>
<td>20</td>
<td>40</td>
<td>80</td>
<td>160</td>
<td>320</td>
</tr>
<tr>
<td>50µs</td>
<td>40</td>
<td>81</td>
<td>162</td>
<td>325</td>
<td>650</td>
</tr>
<tr>
<td>100µs</td>
<td>100</td>
<td>200</td>
<td>400</td>
<td>800</td>
<td>1600</td>
</tr>
<tr>
<td>200µs</td>
<td>200</td>
<td>400</td>
<td>800</td>
<td>1600</td>
<td>3200</td>
</tr>
<tr>
<td>500µs</td>
<td>406</td>
<td>812</td>
<td>1625</td>
<td>3250</td>
<td>6500</td>
</tr>
<tr>
<td>1ms</td>
<td>1000</td>
<td>2000</td>
<td>4000</td>
<td>8000</td>
<td>16000</td>
</tr>
<tr>
<td>2ms</td>
<td>2000</td>
<td>4000</td>
<td>8000</td>
<td>16000</td>
<td></td>
</tr>
<tr>
<td>5ms</td>
<td>4062</td>
<td>8125</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10ms</td>
<td>10000</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The default plot for CA is the current vs. time plot ($I$ vs $t$). The plot for CC can be displayed by right-clicking on the graph and selecting $Q$ vs $t$ in the Derived Graphs menu. This plot is calculated by the software by integrating the $I$ vs $t$ plot. Derived graphs $Q$ vs $\sqrt{t}$ and $I$ vs $\frac{1}{\sqrt{t}}$ can also be displayed.

For information on CA analysis, please see Appendix D.

**Controlled Potential Electrolysis (CPE)**

The principle behind the Controlled Potential Electrolysis (CPE) experiment is very simple. If only the oxidized species is initially present, then the potential is set at a constant value
sufficiently negative to cause rapid reduction and is maintained at this value only until the reduced species is present in solution. The total charge passed during the CPE experiment (Q) is calculated by integrating the current and is related to the number of electrons transferred per molecule (n) and the number of moles of the oxidized species initially present (N) through Faraday's law:

\[ Q = nFN \]

where F is Faraday's constant (96500 C mol\(^{-1}\)). Therefore, if one of n or N is known, the other can be calculated. Hence, CPE has both analytical and synthetic applications.

A Stabilization Capacitor between the auxiliary and reference electrodes is switched in during the CPE experiment. The capacitor can be set to Large (0.1\(\mu\)F), Small (0.01\(\mu\)F), or None.

The End Condition of the CPE experiment can be set by the user in a number of ways. The most basic criterion is the Time Limit, which must be set by the user; that is, the experiment will end after a user-defined time period (select Time Limit Only for the end condition). However, there are three optional criteria that can also be set:

- Charge Limit: the absolute value of the charge limit should be specified
- Minimum Current Limit: the absolute minimum current value should be specified
- Current/Initial Current Ratio: the criterion is the ratio of the final current to the initial current in parts per thousand

Any single one of these optional criteria can be used in addition to the time limit. However, it is important to note that the time limit always takes precedence; that is, if the time limit is attained before, for example, the charge exceeds the charge limit, the experiment will end. It should also be noted that there will typically be a delay of 1 or 2 seconds between the time the selected criterion is exceeded and the termination of the experiment, due to the time required for data processing. If any of these optional criteria are used, the multi-run capability is disabled.

Range of allowed parameter values:

- Potential: ±3275mV or ±10V
- Sample Interval: 0.05, 0.1, 0.2, 0.5, 1, 2, 5, 10, 30, or 60s
- Time Limit: 0-32000 in seconds or minutes (see below)

The maximum value for the Time Limit is also determined by the Sample Interval, since a maximum of 64,000 data points can be recorded in one experiment.

The output from a CPE technique is a current vs. time plot. The charge vs. time plot can be displayed by right-clicking on the graph and selecting Q vs t in the Derived Graphs menu.

For information on CPE analysis, please see Appendix E.

DC Potential Amperometry (DCPA)

DC Potential Amperometry (DCPA) is the simplest technique on the Epsilon EClipse™. A constant potential is applied to the electrochemical cell, and the current response is monitored. Typical applications of this technique include amperometric titrations, amperometric sensors, flow cells (including liquid chromatography with electrochemical detection), etc.
The DCPA experiment can be run on a hanging mercury drop electrode (i.e. a single drop is used for the entire experiment) using a BASi CGME by selecting **CGME SDME Mode** in the **Cell Selection** box. A rotating disc experiment can be run using a BASi RDE-2 by selecting **RDE-2** in the **Cell Selection** box, and entering the require **RPM** (please note that the CGME and/or the RDE-2 must be selected in the **Instrument** menu by going to **Setup**).

The end of the DCPA experiment is determined by the **Time Limit**, although the experiment can be ended by the user before that time.

Range of allowed parameter values:

- **Potential**: ±3.275V or ±10V
- **Sample Interval**: 0.05, 0.1, 0.2, 0.5, 1, 2, 5, 10, or 60s
- **Time Limit**: 0-32000 (see below)

The maximum value allowed for **Time Limit** is also determined by the **Sample Interval**, since a maximum of 64,000 data points can be recorded in one experiment.

The **Applied Potential** is determined by the redox potential of the analyte. For example, if DCPA is used for EC detection for HPLC, the potential should be such that the analyte is electrolyzed at the mass-transport limited rate (as determined by hydrodynamic voltammetry). However, the increase in noise and the decrease in selectivity with increasing positive or negative potentials may also need to be considered when selecting the potential value.

**Open Circuit Potential vs. Time (OP)**

The Open Circuit Potential (also referred to as the equilibrium potential, the rest potential, or the corrosion potential) is the potential at which there is no current; that is, experiments based on the measurement of the open circuit potential are potentiometric experiments. Although such measurements are very simple, they have many important applications, which are briefly discussed below.

Setting up an OP technique is very simple. Please note that the multi-run option is not available for this technique. In addition to this measurement, the open circuit potential can be monitored using **Measure Open Circuit Potential** in the **Experiment** menu. Furthermore, this potential can be measured before another experiment (i.e. cyclic voltammetry) and can be automatically used as the initial potential.

The basis of potentiometric concentration measurements (i.e. for potentiometric titrations) is the Nernst equation, which relates to the concentration of electroactive species at the electrode surface ($C^S$) to the potential at that electrode ($E$); that is, for the reaction $O + e^- = R$

$$E = E^{0'} + \frac{0.059}{n} \log \frac{C^S}{C^R}$$

Where $E^{0'}$ is the formal redox potential of the electron transfer reaction. The potential $E$ is measured between two electrodes: the indicator electrode and the reference electrode (the auxiliary electrode is disconnected for potentiometric measurements on the epsilon). The indicator electrode is selected such that its potential is sensitive to the concentration of the analyte in solution (i.e. a glass membrane electrode for the measurement of pH), and the reference electrode (i.e. the saturated calomel or the silver/silver chloride electrode) provides a stable reference potential for the measurement of the potential of the indicator electrode.
Other important open circuit potential measurements are the open circuit potential of a battery, and the equilibrium (corrosion) potential of a corroding system.

**Chronopotentiometry (CP)**

Epsilon EClipse™ instruments contain both a potentiostat and a galvanostat, and hence can perform both controlled potential (potentiostatic) and controlled current (galvanostatic) experiments. Although potentiostatic experiments are much more common, there are some applications for which a galvanostat is advantageous.

The galvanostat uses a three electrode configuration, in which a current is applied between the auxiliary and working electrodes, and the potential of the working electrode (measured with respect to the reference electrode) is monitored. The basis of controlled current experiments is that a redox (electron transfer) reaction must occur at the surface of the working electrode in order to support the applied current. For example, if ferricyanide is present in the solution, then a reducing current will lead to the reduction of ferricyanide to ferrocyanide at the working electrode (note that a balancing oxidation must also occur at the auxiliary electrode). Common applications of the galvanostat include constant current stripping potentiometry and constant current electrolysis (including applications where a constant rate of electrolysis is important, such as electrodeposition and battery studies). One advantage of all constant current techniques is that the ohmic drop due to solution resistance is also constant, as it is equal to the product of the current and the solution resistance. The ohmic distortion can therefore be simply corrected by a constant potential offset. In contrast, in potentiostatic experiments (i.e. cyclic voltammetry), the current, and hence the ohmic drop, varies with potential, and correction is more complicated.

Chronopotentiometry (CP) is the most basic constant current experiment. In CP, a current step is applied across an electrochemical cell (without stirring).

**Applied Current** values are entered in mA, μA, nA, or pA, depending on which **Applied Current Range** is selected. The current polarity is determined by the **Applied Current Convention** (IUPAC for positive oxidation current, Polarographic for positive reduction current. The end of the experiment can be determined by the **Time Limit** or by the **End at Upper Limit/End at**
Lower Limit selections (range of values depends on which Potential Measurement Range is selected). The experiment can also be ended manually.

Range of allowed parameter values:

- **Current:** 50pA-50mA (see below)
- **End Condition E Limit:** ±999mV or ±9999mV (depending on Potential Range selection)
- **Sample Interval:** 0.05, 0.1, 0.2, 0.5, 1, 2, 5, 10, 30, or 60s
- **Time:** 32000 (see below)

Please note there are accuracy limitations when applying sub-nA currents. The Epsilon EClipse™ typically has a background current of about 30pA, and a drift of about 5pA over an 8 hour period. However, it may be possible to determine the average background current for a given instrument, and hence “correct” the applied current to compensate for the background and drift.

The maximum number of data points that can be collected in one experiment is 64,000, so the maximum value for the **Time** of a given experiment is also determined by the **Sample Interval**.

For information on CP analysis, please see **Appendix F**.

**Basic Plus Techniques**

A number of different pulse techniques are available in the Basic Plus package for the Epsilon EClipse™, which differ in their potential pulse wave forms, the number of sampling points, and whether a solid electrode (voltammetry) or a mercury drop electrode (polarography) is used. The discrimination against the charging current that is inherent in these techniques leads to lower detection limits (when compared to linear sweep techniques), which makes these techniques suitable for quantitative analysis.

The basis of all pulse techniques is the difference in the rate of the decay of the charging and the faradaic currents following a potential step (or “pulse”). The charging current decays exponentially, whereas the faradaic current (for a diffusion-controlled current) decays as a function of 1/(time)½, that is, the rate of decay of the charging current is considerably faster than the decay of the faradaic current. The charging current is negligible at a time of 5R_Cdl after the potential step (R_Cdl is the time constant for the electrochemical cell, and ranges from µs to ms). Therefore, after this time, the measured current consists solely of the faradaic current; that is, measuring the current at the end of a potential pulse allows discrimination between the faradaic and charging currents.

The important parameters for pulse techniques are as follows:

1. **S.W./Pulse Amplitude** is the height of the potential pulse. This may or may not be constant depending upon the technique.
2. **Pulse/Step Width** is the duration of the potential pulse.
3. **Sample Period** is the time at the end of the pulse during which the current is measured.
4. For some pulse techniques, the **Pulse Period** or **Drop Time** must also be specified. This parameter defines the time required for one potential cycle, and is particularly significant for polarography (i.e. pulse experiments using a mercury drop electrode), where this time corresponds to the lifetime of each drop (i.e. a new drop is dispensed at
the start of the drop time, and is knocked off once the current has been measured at the end of the drop time - note that the end of the drop time coincides with the end of the pulse width).

In each pulse technique, the Pulse Type must be specified when using a mercury electrode (CGME SMDE Mode). If Voltammetry is selected, the whole experiment is performed on a single mercury drop (after the Pre Run Drops). If Polarography is selected, a new drop is used for each data point.

Three options are available for Sample Period:

- The current is measured once at the end of the Step/Pulse Width (1 Point).
- The current is measured multiple times in 1ms at the end of the Step/Pulse Width (1 mSecond).
- The current is measured multiple times over 1 line cycle at the end of the Step/Pulse Width, and averaged (1 Line Period). The time required for 1 line cycle is the reciprocal of the line frequency (16.7ms for 60Hz, and 20ms for 50Hz). The line frequency is selected in the Setup under the Instrument menu.

Generally speaking, increasing the Sample Period increases the signal-to-noise ratio. However, the 1 Line Period option may not be possible for short Step/Pulse Width values.

Sampled Current Polarography

Sampled current polarography (SCP) is a modification of the classical DC polarography experiment, and was designed to reduce the effect of the changing surface area of the mercury drop electrode. The potential wave form is shown in below. The potential is varied in a series of steps, with the current sampled at the end of each step.

Range of allowed parameter values:

- Potential: ±3275mV or ±10V
Step Potential: 1-40mV  
Step Width: 100-6550ms (Polarography) or 4-6550ms (Voltammetry)  
Quiet Time: 0-100s

The scan rate cannot be directly changed by the user, and is determined by Step Potential x 1/Sample Width.

The current response for SCP is shown below. The limiting current ($i_d$) is given by the Ilkovic equation:

$$i_d = 708nCD^{1/2}m^{2/3}\tau^{1/6}$$

where:  
n = number of electrons transferred/molecule  
C = concentration (mol cm\(^{-3}\))  
D = diffusion coefficient (cm\(^2\) s\(^{-1}\))  
m = mercury flow rate (mg s\(^{-1}\))  
τ = sampling interval (s)

A typical sampled current polarogram

**Normal Pulse Voltammetry/Polarography (NP)**

The potential waveform for normal pulse voltammetry/polarography (NP) is shown below. The potential waveform consists of a series of pulses of increasing amplitude, with the potential returning to the initial value after each pulse.
Range of allowed parameter values:

- Potential: ±3275mV or ±10V
- Step Potential: 1-40mV
- Step Width: 100-6550ms (Polarography) or 4-6550ms (Voltammetry)
- Quiet Time: 0-100s

The scan rate cannot be directly changed by the user, and is determined by Step Potential x 1/Pulse Period. The Pulse Period must be at least twice the Pulse Width.

Consider a reduction. If the Initial Potential is well positive of the redox potential, the application of small amplitude pulses does not cause any faradaic reactions; hence there is no current response. When the pulse amplitude is sufficiently large that the pulse potential is close to the redox potential, there is a faradaic reaction in response to the potential pulse (assuming moderately fast electron transfer kinetics), and the magnitude of this current may depend on both the rate of diffusion and the rate of electron transfer. When the pulsed potentials are sufficiently negative of the redox potential that the electron transfer reaction occurs rapidly, the faradaic current depends only on the rate of diffusion; that is, a limiting current has been attained. The sigmoidal shape typically observed for NP (see below) is similar to the shape of the current-potential curve obtained in the classical polarography experiment, which gives rise to the name of “normal” for this technique.
Differential Pulse Voltammetry/Polarography (DP)

The potential wave form for differential pulse voltammetry/polarography (DP) is shown below. The potential wave form consists of small pulses (of constant amplitude) superimposed upon a staircase wave form. Unlike NP, the current is sampled twice in each Pulse Period (once before the pulse, and at the end of the pulse), and the difference between these two current values is recorded and displayed.
Range of allowed parameter values:

- Potential: ±3275mV or ±10V
- Step Potential: 1-40mV
- Pulse Amplitude: 5-250mV
- Pulse Width: 3-1000ms
- Step Width: 100-6550ms (Polarography) or 4-6550ms (Voltammetry)
- Quiet Time: 0-100s

The scan rate cannot be directly changed by the user, and is determined by Step Potential x 1/Pulse Period. The Pulse Period must be at least twice the Pulse Width.

Consider a reduction. At potentials well positive of the redox potential, there is no faradaic reaction in response to the pulse, so the difference current is zero. At potential around the redox potential, the difference current reaches a maximum, and decreases to zero as the current becomes diffusion-controlled. The current response is therefore a symmetric peak (see below).

A typical differential pulse voltammogram

**Square Wave Voltammetry (SW)**

The potential wave form for square wave voltammetry (SW) is shown below. The potential wave form consists of a square wave of constant amplitude superimposed on a staircase wave form. The current is measured at the end of each half-cycle, and the current measured on the reverse half-cycle (i_r) is subtracted from the current measured on the forward half-cycle (i_f). This difference current (i_f - i_r) is displayed as a function of the applied potential.
Potential waveform for square wave voltammetry

The step height of the staircase waveform and the potential resolution is determined by the $1/\text{S.W. Frequency}$.

Three options are available for Sample Period:

- The current is measured once at the end of each half-cycle (1 Point – maximum S.W. Frequency = 2000Hz).
- The current is measured multiple times in 1ms at the end of each half-cycle, and averaged (1 mSecond – maximum S.W. Frequency = 125Hz).
- The current is measured multiple times over 1 line cycle at the end of the Pulse Width, and averaged (1 Line Period). The time required for 1 line cycle is the reciprocal of the line frequency (16.7ms for 60Hz, and 20ms for 50Hz). The line frequency is selected in the Setup under the Instrument menu.

The experiment can be run on a hanging mercury drop electrode (i.e. a single drop is used for the entire experiment) using a BASi CGME by selecting CGME SDME Mode in the Cell Selection box.

Range of allowed parameter values:

- Potential: ±3275mV or ±10V
- Step Potential: 1-40mV
- S.W. Amplitude: 1-250mV
- S.W. Frequency: 1-2000Hz
- Quiet Time: 0-100s

The scan rate cannot be directly changed by the user, and is determined by Step Potential x S.W. Frequency.
There are two advantages to measuring the difference current. First, it increases the discrimination against the charging current, since any residual charging current is subtracted out. Second, the shape of the current response is a symmetric peak (see below), rather than the sigmoidal curve typically found for normal pulse voltammetry. If we consider a reduction, then at potential well positive of the redox potential, both the forward and reverse currents are zero, so the difference current is also zero. At potentials well negative of the redox potential, the current is diffusion-controlled, and the potential pulse has no effect; hence, the forward and reverse currents are equal, and the difference current is again zero. The largest difference between the forward and reverse currents (and hence the largest current response) is at the redox potential.

A typical square wave voltammogram

**Stripping Voltammetric Techniques (LSSV, SWSV, DPSV)**

Stripping voltammetry is a very sensitive method for the analysis of trace concentrations of electroactive species in solution. Detection limits for metal ions at sub-ppb concentrations have been reported.

There are three important parts in a stripping experiment:

- Deposition
- Quiet time
- Stripping

These components can best be explained by discussing the stripping experiment for detection of lead. In this experiment, a mercury working electrode is used – either the Hanging Mercury Drop Electrode (HMDE) (using the BASi CGME) or the Thin Mercury Film Electrode (TMFE).
(using the BASi RDE-2). The TMFE is made by depositing a mercury film on the surface of a glassy carbon electrode, typically during the deposition step.

During the deposition step, the potential applied to the mercury electrode is held at a Deposition Potential (mV) at which the lead ions are reduced to lead metal for a predetermined Deposition Time (sec). If the Deposition E = Initial E option is enabled, the Initial Potential (mV) in the Technique Parameters is used as the deposition potential. The metallic lead than amalgamates with the mercury electrode (when the TMFE is used, mercuric ions are generally added to the solution, and mercury metal is co-deposited with the lead during the deposition step). The effect of this amalgamation is to concentrate the lead in the mercury electrode, and hence the concentration of lead in the electrode is much greater (typically 2 or 3 orders of magnitude) than the concentration of lead in the solution (consequently, the deposition step is often called the pre-concentration or accumulation step). The efficiency of the deposition can be increased by either stirring the solution (when using the CGME) or rotating the electrode (when using the RDE-2). Stir/Rotate during Deposition and Purge during Deposition can be enabled to remotely control the CGME/RDE-2. In the Cell Settings, the Cell Selection should be set to CGME/SDME Mode or RDE-2, depending on which is to be used.

After the deposition step, the stirring is stopped, and the system is allowed to reach equilibrium (typically 10-15 seconds). This is the Quiet Time (s) found under the Start Conditions section.

During the stripping step, the applied potential is scanned in a positive direction, and the lead in the mercury electrode is oxidized back to lead ions in solution; that is, the lead is "stripped" from the electrode. The potential at which the stripping occurs is related to the redox potential of the analyte, and hence the potential of the current peak on the stripping step can be used to identify the analyte. The magnitude of the current of the stripping peak is proportional to the concentration of the analyte in the mercury electrode. Since the concentration of the analyte in the electrode is related to its concentration in solution, the stripping peak current is therefore proportional to the solution concentration.

A number of different wave forms have been used for the stripping step, including Linear Sweep Voltammetry (LSSV), Differential Pulse Voltammetry (DPSV), and Square Wave Voltammetry (SWSV). SWSV and DPSV are more commonly used, due to their lower detection limits. For more detailed information on specific technique parameters, please see the sections on Linear Sweep Voltammetry, Differential Pulse Voltammetry, and Square Wave Voltammetry, respectively.

As noted above, it is the concentration of lead in the mercury electrode that is directly measured in the stripping step rather than the concentration of lead in solution. The electrode concentration can be increased by increasing the Deposition Time (sec) and/or the rate of stirring. The values required for these two parameters depends on the sensitivity of the mercury electrode, which is determined by the surface area to volume ratio (i.e., how many of the deposited lead atoms are on the mercury surface and hence are detectable in the stripping step). This ratio is considerably higher for the TMFE, so a shorter Deposition Time (sec) is required. In addition, faster stirring can be used with the TMFE due to the relative mechanical instability of the HMDE (i.e., the mercury drop can fall off if the stirring is too fast). The signal resolution is also better with the TMFE, which can be important if there is more than one metal ion present.
However, the greater sensitivity of the TMFE can also be a disadvantage, since the solubility limit of the metal in the mercury can be exceeded more readily. This can lead to the formation of intermetallic compounds, which can affect the accuracy of the experimental results (due to e.g., shifts in the stripping potentials and depression of the stripping currents). One pair of metals that readily combine is zinc and copper.

In order to be of use as a quantitative analytical technique, the results of a stripping experiment must be reproducible. Therefore, the experimental conditions must be reproducible. A second disadvantage of the TMFE is the relatively poor reproducibility of the film. Since the film is deposited on the surface of a glassy carbon electrode, it is sensitive to the microstructure of the glassy carbon surface, which can be affected by the method used to prepare the surface. In contrast, an HMDE is highly reproducible. Whatever the chosen mercury electrode, great care must be taken in sample preparation, cleaning of glassware, etc. The rate of stirring during the deposition step must also remain constant.

The above method is called anodic stripping voltammetry (ASV), since the stripping current is anodic. This method can be used for metal ions that can be readily reduced to the metallic state and re-oxidized, which includes about 20 different metal ions (e.g. lead, copper, cadmium, and zinc). This is not as many as can be detected using atomic absorption spectroscopy (AAS), although the sensitivity of ASV is comparable with, and sometimes better than AAS. The advantage of ASV over AAS is its ability to detect several metal ions simultaneously. In addition, different oxidation states of a given metal can be detected (e.g., arsenic and antimony).

Other stripping voltammetric techniques include cathodic stripping voltammetry (CSV) and adsorptive stripping voltammetry (AdSV). The basis for CSV is the oxidation of mercury followed by the formation of an insoluble film of HgL (L is the analyte) on the surface of the mercury electrode during the deposition step. CSV is most commonly used for detection of sulfur-containing molecules (e.g., thiols, thioureas, and thioamides), but it has also been used for molecules such as riboflavin and nucleic acid bases (e.g., adenine and cytosine).

AdSV is different from ASV and CSV in that the deposition step is non-electrolytic, and occurs via the adsorption of molecules on the surface of the working electrode (the HMDE is most commonly used). The stripping step can be either anodic or cathodic. AdSV has been used for organic molecules (e.g., dopamine, chlorpromazine, erythromycin, dibutone, and ametryne) and for metal complexes of metals not amenable to detection by ASV (e.g., cobalt and nickel).

**Double Step Chronopotentiometry (DSCP)**

Double Step Chronopotentiometry (DSCP) is similar to CP; however in this technique a second current step is applied. It should also be noted that the time scale of a DSCP experiment is typically shorter (seconds or milliseconds) than that of CP (minutes or seconds). The protocol for defining the sampling rate is therefore different for the two techniques.
Four parameters are used to define the current waveform for DSCP: **First Step Current**, **Second Step Current**, **First Step Time**, and **Second Step Time**. The current values are entered in mA, μA, nA, or pA, depending on which **Current Range** is selected. The current polarity is determined by the **Applied Current Convention** (IUPAC for positive oxidation current, **Polarographic** for positive reduction current).

Range of allowed parameter values:

- **Current:** 50pA-32mA (see below)
- **Step Time:** 1-655 or 1-16000ms
- **Maximum # of points in a step:** 1000, 2000, 4000, 8000, 16000
- **Sample Interval:** 0.05, 0.1, 0.2, 0.5, 1, 2, 5, 10, 30, or 60s
- **Time:** 32000 (see below)

Please note there are accuracy limitations when applying sub-nA currents. The Epsilon EClipse™ typically has a background current of about 30pA, and a drift of about 5pA over an 8 hour period. However, it may be possible to determine the average background current for a given instrument, and hence “correct” the applied current to compensate for the background and drift.

The **Sample Interval** is determined by the **Step Time** and the **Maximum # of points in a step**, and can only be adjusted by the user indirectly through those parameters. For more details on the **Sample Interval** limitations, please see the section on CA.

For information on CP analysis, please see **Appendix F**.

**Bipotentiostat Techniques**

Multichannel techniques are available on the Epsilon EClipse™ by the addition of the optional bipotentiostat upgrade. Bipotentiostat experiments can be run for cyclic voltammetry, chronoamperometry, and DC amperometry.
Multi-Channel Amperometry (MCA)

The W2 Applied Potential can be automatically set to the same value as W1 (Track W1), or a different value can be entered (Fixed Potential).

Multi-Channel Cyclic Voltammetry (MCCV)

There are two options available for the W2 Applied Potential:

- Fixed Potential: Channel 2 is held at a set potential value, as defined by the Fixed Potential. Typical output from a “scan-hold” experiment is shown below.

- Potential Scan: Channel 2 is scanned over the same potential range and at the same scan rate as Channel 1 (Track W1). Typical output from a “scan-scan” experiment is shown below.
Note that in either case, the **W2 Full Scale Current** must also be specified.

**Multi-Channel Chronoamperometry (MCCA)**

There are two options available for the **W2 Applied Potential**:

- **Fixed Potential**: Channel 2 is held at a set potential value, as defined by the **Fixed Potential**.
- **Potential Step**: The step potentials and times for Channel 2 are the same as those used for Channel 1 (**Track W1**). Typical output from a "step-step" experiment is shown below.
Note that in either case, the **W2 Full Scale Current** must also be specified.

### 7.6. Experiment

**Run/Stop** - After choosing a technique and changing the experimental parameters to the desired values, the experiment can be started by selecting **Run** in the **Experiment** menu or by selecting the **Run** icon. The experiment can be stopped by selecting **Stop** in the **Experiment** menu or by selecting the **Stop** icon.

**Sequential Techniques** – Sequential techniques allows the user to set up a batch experiment with a virtually unlimited number of sequential experiments. Sequential techniques is included as part of the Methods software package. Sequential techniques can be entered by selecting **Sequential Techniques** in the **Experiment** menu.

1. To initiate a new experiment, select the desired technique from the Available Technique list, and then click **Insert Tech**. The new experiment will be highlighted, and placed at the bottom of the list or after the currently highlighted technique in the sequence.
2. The technique can be edited by highlighting the technique in the sequence and selecting **Edit**. The scan rate increment and applied E increment can be checked on or off enable and values can be input.
3. To delete an experiment, highlight the appropriate experiment, and then click **Delete**.
4. A previously saved sequence can be selected by clicking **Open** in the **Tech Sequence File** section of the **Sequential Techniques** dialog box.
5. The following can be programmed to occur during the sequence – Select Insert Delay to insert a delay into the sequence. The delay can be edited by highlighting delay in the sequence and selecting Edit. The length of delay time can be selected, stir can be checked on or off, purge can be checked on or off, and in the event relay dropdown box set off, set on, pulse off, or pulse on can be selected.

6. Multiple cycles of the defined sequence of experiments can be programmed by changing the number of total runs in the box in the control section of the sequential techniques dialog box.

7. Once the sequence has been programmed, select Run to start the sequence. The sequence can be stopped by selecting Stop.

8. To choose the location of saved data, enter the desired location into the box in the Data Path section of the Sequential Techniques dialog box and click Set.

9. A programmed Sequential Technique can be saved for future use by selecting Save in the Tech Sequence File section of the Sequential Techniques dialog box.

7.7. Graphing

The options available for the graphical display of the experimental data are listed below. These are contained in the Graph menu, and also in the Graph Properties window.

**Zoom**

When data is displayed in an experimental window (during or after an experiment, or after opening saved data), the axis limits are defined by the data points, as shown below.

![Screenshot of Ferrocene.CV0 without peak parameters](image)

Three zoom options are available: **Zoom Full Range**, **Zoom All Data**, or mouse zoom. **Zoom Full Range** will increase the y-axis to the values defined by Full Scale Current in the technique parameters.

![Screenshot of Ferrocene.CV0 without peak parameters, Zoom Full Range](image)

**Zoom All Data** will restore the default zoom on the data points. The mouse scroll-wheel can also be used to zoom in and out of data. Additionally, the user can define the zoom area of the window by clicking the mouse in one area of the data and dragging the cursor to an opposite corner while holding down the mouse button.

![Screenshot of Ferrocene.CV0 without peak parameters, partial zoom on duck head](image)

The **Undo Zoom** menu selection will undo the last zoom the user implemented.

**Change Display Type**

Two axes conventions are available:

- **IUPAC**: Positive x = positive potentials; positive y = oxidative currents
- **POLAROGRAPHIC**: Positive x = negative potentials; positive y = reduction currents
Both graph types can be accessed from the **Graph** menu.

## Select Graph Type

Many options exist for the graphing of data collecting during a technique. These options can be accessed by right-clicking in the graph area, or through the **Graph → Select Graph Type** menu.

### Raw vs. Processed Data

The graph can display either raw data, or apply post-run smoothing.

### X- and Y-axes

Data graphs are initially shown in their default graph type (varies per technique). There are a variety of other graph types that can be used to analyze the data:

- **I vs E** (current vs. potential)
- **I vs t** (current vs. time)
- **E vs t** (potential vs. time)

The following derived graph types can also be displayed:

- **Q vs t** (charge vs. time)
- **Q vs sqrt(t)** (Anson plot)
- **I vs 1/sqrt(t)** (Cottrell plot)
- **Semi Int** (integration of current vs. potential)
- **Semi Diff** (differentiation of current vs. potential)
- **SW Difference** (current vs. potential)
- **SW Forward** (current vs. potential)
- **SW Reverse** (current vs. potential)

For multi-channel techniques, W1 and W2 data can be displayed together, or just one channel’s data can be displayed using **Multichannel W1** and **Multichannel W2** options.

Please see section 7.5 for more information on which graph types are available for each specific technique.
Show Data Points

This option can be enabled or disabled in the Graph menu. Enabling this option will generate a graphic in which all the experimental data points are displayed (see example below).

Data Display Settings

This menu option allows you to set the exact extents of the displayed graph.
Graph Properties Toolbar

The Graph Properties Toolbar can be accessed from the View → Toolbars and Docking Window menu. This toolbar can be a floating window within the software, or it can be docked on the sides, top, or bottom of the software window. While docked, the toolbar can be left open, or it can be set to automatically hide when not in active use. The Graph Properties Toolbar will always show/change the settings of the active window.

Captions

All graphs have default titles and axis labels. However, the user can enter custom titles and axis labels in this section of the Graph Properties Toolbar.

Fonts

Fonts can be adjusted independently for the graph title, the axis labels, and the axis tick mark values.

Colors

All of the various features in the graph can be set to any color, or the graph can be displayed in Black and White Mode.

Show

In this section of the Graph Properties Toolbar, the grid lines and axis settings can be changed. The Grid can be enabled or disabled. The Zero Line for either axis can be also be enabled or displayed, regardless of whether the overall grid is displayed. Data Points can also be enabled or disabled in this section of the toolbar.
7.8. Data Analysis

The parameters that can be extracted from experimental data depend upon the electrochemical technique (e.g., peak potential, peak current, and peak area for cyclic voltammetry, and slope and intercept for chronoamperometry/chronocoulometry). Therefore, different measurement methods are required for different techniques. The following data analysis methods are available on the Epsilon EClipse™.

Peak Parameters

This function can be found in the Analysis menu under Peak Parameters. This function will measure and report the peak potential, current, and area under the peak for symmetric and tailing peaks, and the half-wave potential and limiting current for sigmoidal curves. The baselines for these measurements can either be determined automatically by the software or manually by the user. The operation of this function is best illustrated by the example below.

The cyclic voltammogram to be analyzed is shown above. The peak parameter values are calculated using the default values for the peak finding function.
The peaks found will be based on the **Min Width** and **Min Height** parameters. After changing these values, click the **Calculate** button to recalculate the peaks.

Selecting a peak will show only that peak on the graph. Click the **Redraw** button to restore the view with all peaks.

Checking the **Paint Peaks** box and the clicking **Redraw** will show the calculated area for each peak.

All peak baselines and peak lines are saved with the data file. If one reanalyzes saved data, then be sure to resave the file.
Linear Fit Measurement

Data from potential step experiments can be analyzed using the linear relationship between the response and some function of time. While viewing a data file, change the graph type to Q vs sqrt(t) or I vs 1/sqrt(t). Then select Calculate CA-SIR from the Analysis menu.

There are two parameters to be specified for the linear fit. R-Window specified the percentage of data points to be used in the fit. This parameter is required since the finite time required to change the potential from the initial value to the step value means that the first few data points are not valid. The default condition is that the final 80% of the data points are used for the calculation (i.e. the first 20% are discarded). W is the weighting factor used in the calculation (x, 1/x, or 1/x²). On clicking Calculate, the parameter values are calculated and displayed in the window (see figure below).

The graph now displays the lines used for the calculations.
File Overlay

Data files can be superimposed on a single set of axes using the **Overlay Waveforms** function in the **Graph** menu. Open all the files you wish to overlay, and the overlay will automatically be generated when you select the menu option. The axis scale is determined by the graph with the largest extents.

If you wish to remove one of the graphs from the overlay, simply close that file and it will disappear.

Please note that the Graph Properties menu is not active for overlays.

Overlays can be saved as *.eplot files. When reopening this file, the original data files must first be opened.

**Moving Point Averaging**

Digital smoothing routines are used to remove unwanted noise from the electrochemical signal after the experimental run, thereby improving the signal-to-noise ratio. However, as with analog filtering, care must be taken to avoid biasing the electrochemical signal.

The default smoothing routine on the Epsilon EClipse™ is the moving average smooth. This can be selected in the **Analysis** menu under three options: **MPA 5 Points**, **MPA 9 Points**, or **MPA n Points**.

For example, when using **MPA 5 Points**, data are examined in 5 point blocks. Within each block, the first, second, fourth, and firth points are summed and divided by 4. This number (i.e. an averaged current value) replaces the third point in the block. The routing moves up one point, and repeats the averaging sequence, until it has been repeated for all data points, other than the first two and last two, which are set equal to the third point, and the third from last point, respectively. A 9 point moving point average is also available, or the user may set any \( n \) value.

The default condition is that the experimental data is smoothed automatically at the end of the experiment.
Derived Graphs

Various derived graphs are available, depending on the technique:

Anson Plots

This plot of $Q$ vs. $\sqrt{t}$ is available for chronocoulometric techniques.

Cottrell Plots

This plot of $I$ vs. $\frac{1}{\sqrt{t}}$ is available for chronoamperometric techniques.

These plots can be accessed by right-clicking on the data graph and selecting Derived Graphs. They can also be accessed from the Graph → Select Graph Type menu option.

Please see Appendix D for more information on these data analysis techniques.

7.9. Data Storage and Export

Saving

Data can be saved with the .edata file extension by selecting Save or Save As from the File menu or by selecting the Save icon on the tool bar. The technique can be saved with the .etech file extension by selecting Save or Save As from the File menu or by selecting the Save icon on the tool bar. If using the Methods version of the software, a sequence can be saved with the .eseq file extension by selecting Save or Save As from the File menu or by selecting the Save icon on the tool bar.

Copying

Data can be copied by selecting Copy in the Edit menu. The graph can also be copied by pressing Ctrl+C when the graph window is active. Plot data can be copied by pressing Ctrl+Shift+C for directly pasting into a spreadsheet.

Printing

Information can be printed by selecting Print in the File menu or by selecting the Print icon on the tool bar. Also, Print Preview and Print Setup can be selected in the File menu. Graphs are printed with the technique parameters and notes given below the graph. Graphs can be printed to PDF files if an applicable PDF writer is installed on the computer.

Exporting

Data can be exported by selecting Save Data As from the File menu and allows for the selection of several options. Technique Properties, Legacy Format, Measured Parameter(s) Only, Single Column, and Column Labels can be checked or unchecked. The Column Delimiter can be chosen to be Space, Comma, or Tab. The option to save the data every $n$ number of data points can be chosen by entering the desired numerical value into the box.
8. Maintenance and Troubleshooting

8.1. Working Electrodes

Electrode Polishing

The fundamental process in electrochemical reactions is the transfer of electrons between the working electrode surface and molecules in the interfacial region (either in solution or immobilized at the electrode surface). The kinetics of this heterogeneous process can be significantly affected by the microstructure and roughness of the electrode surface, the blocking of active sites on the electrode surface by adsorbed materials, and the nature of the functional groups (e.g., oxides) present on the surface. Therefore, there has been considerable effort devoted to finding methods that remove adsorbed species from the electrode and produce an electrode surface that generates reproducible results. The most common method for surface preparation is mechanical polishing. The protocol used for polishing depends on the application for which the electrode is being used, and the state of the electrode surface. There are a variety of different materials available (e.g., diamond, alumina, silicon carbide), with different particle sizes suspended in solution (BASi supplies 0.05 mm alumina polish, and 1, 3, 6, and 15 mm diamond polishes; these should be shaken well before use to ensure that the particles are suspended). The pad used for polishing also depends on the material being used for polishing pads are used with alumina polish, and nylon pads should be used with diamond polish. Working electrodes supplied by BASi have first been lapped to produce a flat surface, and have then been extensively polished to a smooth, mirror-like finish at the factory. Therefore, they typically only require repolishing with 0.05 mm or 1 mm diamond polish by the user between experiments. The electrode should be moved in a figure-of-eight motion when polishing to ensure uniform polishing. Materials that have a rougher surface (e.g., commercial electrodes that have been scratched) must first be polished using a larger particle polish, in order to remove the surface defects. After the defects have been removed, the polishing should continue with successively smaller particle size polish (e.g., 15 mm, then 6 mm, then 3 mm, and then 1 mm).
Once polishing has been completed (this can require from 30 s to several minutes, depending upon the state of the electrode), the electrode surface must be rinsed thoroughly with an appropriate solvent to remove all traces of the polishing material (since its presence can affect the electron transfer kinetics). Alumina polishes should be rinsed with distilled water, and diamond polishes with methanol or ethanol. The rinsing solution should be sprayed directly onto the electrode surface. After the surface has been rinsed, electrodes polished with alumina should also be sonicated in distilled water for a few minutes to ensure complete removal of the alumina particles. If more than one type of polish is used, then the electrode surface should be thoroughly rinsed between the different polishes. As discussed above, the effect of any surface pretreatment can be determined by its effect on the rate of electron transfer. This can be judged qualitatively by examining the separation of the peak potentials in a cyclic voltammogram of a molecule whose electron transfer kinetics are known to be sensitive to the state of the surface (a more quantitative determination can be made by calculating the value of the standard heterogeneous rate constant $k_s$ from this peak potential separation). For example, $k_s$ for potassium ferrocyanide at a glassy carbon surface following a simple polishing protocol is typically in the range 0.01 - 0.001 cm s$^{-1}$ (this should be compared with the values measured for $k_s$ for a platinum electrode, which are at least one order of magnitude larger). The strong dependence of the electron transfer kinetics of ferrocyanide on the state of the electrode surface means that there can be significant variations in the peak potential separation after each polishing, since polishing alters the microstructure, roughness, and functional groups of the electrode surface in addition to removing adsorbed species. The materials used for the polishing can also affect the value of $k_s$. For example, the electrode surface can be contaminated by the agglomerating agents required to keep the alumina particles suspended in solution and by the components of the polishing pad. The presence of these species can have a deleterious effect on the electron transfer kinetics by blocking the active sites for the electron transfer reaction. However, it should be noted that such pronounced dependence on the state of the electrode surface is only observed for certain systems (the most well characterized examples are the reduction of ferrocyanide, the oxidation of ascorbate, and the adsorption of dopamine). For such systems, polishing is often used in combination with another pretreatment (e.g., heat or electrochemical). However, for many other systems, the simple polishing described above is adequate (for example, when using non-aqueous electrolytes, since blocking of active sites by adsorbed species is less common in such electrolytes than it is in aqueous electrolytes).

**Electrochemical Pretreatment**

Another method for preparation of the electrode surface that is becoming more widely used is electrochemical pretreatment (ECP), particularly for electrodes which cannot readily be polished (e.g., carbon fiber cylinder electrodes). ECP consists of applying conditioning potentials to the electrode surface before the experiment. As with polishing, this has the effect of removing adsorbed species and altering the microstructure, roughness and functional groups of the electrode surface. The precise ECP protocol depends upon the application, and varies considerably. The potential waveforms typically are either held at, or cycle to, a large positive or negative potential, either using steps or sweeps (constant potential, potential scan, triangular wave, and square wave). Although the development of the preconditioning protocols has been largely empirical, there has been some characterization of the pretreated electrode surface in order to elucidate the reasons for the activation of the electrode surface. For glassy carbon electrode, in addition to the removal of adsorbed species, the preconditioning potential leads to the formation of an oxygen-rich layer on the carbon surface. This layer contains oxides as well as other oxygen-containing functional groups which may catalyze electron transfer reactions (the composition of the functional groups in this layer is sensitive to the pretreatment
conditions, and depends on the solution pH as well as the potentials used for the pretreatment). The oxide layer can also adsorb and/or exchange ions from the solution, which leads to improved detection limits. However, electrochemical pretreatment of electrodes can increase the background current of the electrode relative to that of a polished electrode, which may be disadvantageous for some applications.

8.2. Reference Electrodes

Introduction

In all electrochemical experiments, the reactions of interest occur at the surface of the working electrode. Therefore, we are interested in controlling the potential drop across the interface between the surface of the working electrode and the solution (i.e., the interfacial potential). However, it is impossible to control or measure this interfacial potential without placing another electrode in the solution. Thus, two interfacial potentials must be considered, neither of which can be measured independently. Hence, one requirement for this counter electrode is that its interfacial potential remains constant, so that any changes in the cell potential produce identical changes in the working electrode interfacial potential. An electrode whose potential does not vary with current is referred to as an ideal non-polarizable electrode, and is characterized by a vertical region on a current vs. potential plot. However, there is no electrode that behaves in this way (although some approach ideal non-polarizable behavior at low currents). Consequently, the interfacial potential of the counter electrode in the two-electrode system discussed above varies as current is passed through the cell. This problem is overcome by using a three-electrode system, in which the functions of the counter electrode are divided between the reference and auxiliary electrodes; that is, the potential between the working and reference electrodes is controlled and the current passes between the working and auxiliary electrodes. The current passing through the reference electrode is further diminished by using a high-input-impedance operational amplifier for the reference electrode input.

The requirements for the counter electrode of the two-electrode system include a high exchange current (fast electron transfer kinetics), very large surface area (to lower the current density) and a high concentration of the species involved in the redox reaction, such that the concentrations are not significantly changed by the passage of a current. One previously widely used reference electrode that fulfills these criteria is the saturated calomel electrode (with a large surface area mercury pool). However, since the current passing through the reference electrode in the three-electrode system is many orders of magnitude lower than the current that passes through the two-electrode system, the requirements for the reference electrode are less demanding; hence, smaller, more polarizable electrodes can be used.

One aspect that is often overlooked is the variation of the reference electrode potential with temperature. Ideally, the potential should be temperature independent; however, it typically changes by 0.5 - 1 mV per degree Celsius. Consequently, precise potential measurements require the use of a constant temperature apparatus. In addition, the temperature at which the measurements were carried should always be reported. The absence of any temperature control limits the accuracy of the measurements to about 5 - 10 mV (although this level of precision may be acceptable for some experiments). Two widely used aqueous reference electrodes are the silver/silver chloride electrode and the saturated calomel electrode. These are now discussed in more detail.
Silver/Silver Chloride Reference Electrode

The redox process for this electrode is

\[ AgCl + e^- \rightleftharpoons Ag + Cl^- \]

This electrode consists of a silver wire, coated with silver chloride, which is immersed in a solution containing chloride ions. The BASi RE-5B electrode uses an aqueous solution containing 3M sodium chloride (the use of sodium as the cation rather than potassium is discussed below); a porous CoralPor™ frit is used for the junction between the reference electrode solution and the sample solution. The potential E for any electrode is determined by the Nernst equation, which relates E to the standard potential \( E^o \) and the activities of the redox components (the standard potential is the potential of the electrode at unit activity under standard conditions). The Nernst equation for the silver/silver chloride electrode is

\[ E = E^o + \frac{RT}{nF} \ln \frac{1}{\alpha_{Cl^-}} \]

(the activities of the solid silver and silver chloride under standard conditions are unity).

It is generally more convenient to consider concentrations rather than activities. These parameters are related by the activity coefficient \( \gamma \):

\[ \alpha_{Cl^-} = \gamma_{Cl^-} [Cl^-] \]

The Nernst equation can therefore be rewritten as follows:

\[ E = E^o + \frac{RT}{nF} \ln \frac{1}{[Cl^-]} \]

where \( E^o \) is the formal potential and is related to the standard potential by the equation:

\[ E = E^o + \frac{RT}{nF} \ln \frac{1}{\gamma_{Cl^-}} \]

When quoting a redox potential, it is important to be specific. For example, the standard redox potential \( (E^o) \) for the silver/silver chloride redox reaction at 25 °C is +0.222 V (vs. NHE), whereas the redox potential (E) for the BASi aqueous silver/silver chloride with 3M sodium chloride reference electrode at this temperature is +0.209 V (vs. NHE). The above equations show that variations in the chloride ion concentration in the electrode change the redox potential. Since there is generally a large chloride concentration gradient across the reference electrode frit, there is slow diffusion of chloride ions from the reference electrode solution into the sample solution; that is, the reference potential will gradually change when used. There are some precautions that can be taken to minimize this potential drift. When the electrodes are made, the CoralPor™ frit is covered in plastic to prevent leakage. This plastic should be carefully removed immediately upon receipt, and the CoralPor™ frit should be immersed in a 3M aqueous sodium chloride solution. The reference electrode should also be removed from the electrochemical cell and stored in this solution between experiments (this is particularly important when using non-aqueous solvent systems, for reasons discussed below). Occasionally, air
bubbles will form in the solution next to the CoralPor™ frit; these should be removed by gently flicking the end of the electrode.

Saturated Calomel Reference Electrode

The redox process for this electrode is

$$Hg_2Cl_2 + 2e^- \rightleftharpoons 2Hg + 2Cl^-$$

The BASi saturated calomel electrode (SCE) is an H-cell. One arm contains mercury covered by a layer of mercury(II) chloride (calomel). This is in contact with a saturated solution of potassium chloride; a porous CoralPor™ frit is again used for the junction between the reference electrode solution and the sample solution at the end of the other arm. The saturated calomel electrode is provided as a kit requiring user assembly (N.B. the kit does NOT include any mercury). Once assembled, the electrode should be stored with the CoralPor™ frit immersed in a saturated solution of potassium chloride to maintain the chloride concentration in the reference electrode.

Liquid Junctions Potentials

As noted above, the composition of the reference electrode solution (i.e., high chloride ion concentration) is generally different from the composition of the sample solution. This leads to a potential difference across the interface of the two solutions (i.e., the CoralPor™ frit), due to unequal rates of diffusion of the constituent ions through the frit. This liquid junction potential cannot be measured (although it can be estimated), and can cause problems with voltammetric measurements. For example, the redox potentials of a given analyte measured in different solvent systems cannot be directly compared, since the liquid junction potential will be different for each solvent system. However, the junction potential can generally be ignored for a given solvent system provided it is constant and reproducible. If there is any doubt that this is so, an internal reference (e.g., ferrocene) can be used; that is, the reference compound is added to the sample solution at the end of the experiment, and its redox potential is recorded. This approach can also be used to compare redox potentials measured in different solvent systems.

Using Aqueous Reference Electrodes in Non-Aqueous Solvents

There has been much debate over the use of aqueous reference electrodes such as the silver/silver chloride electrode and saturated calomel electrode with non-aqueous solvent systems. One area of concern is the junction potentials across the salt bridge, which can range from tens to hundreds of millivolts; however, as discussed above, such problems can be compensated for by the use of an internal reference. There are two more serious problems; the precipitation of electrolyte and the contamination of the sample solution. The electrolytes commonly used in reference electrodes (sodium and potassium chloride) are not very soluble in organic solvents, and prolonged immersion of aqueous reference electrodes in organic solvents can lead to precipitation of these electrolytes in the CoralPor™ frit. Salts that are combinations of the ions of the two electrolytes can also be precipitated; for example, potassium perchlorate is insoluble in acetonitrile, and can be deposited in the frit of an aqueous potassium chloride reference electrode in an acetonitrile solution of tetraethyl ammonium perchlorate. Such precipitation can be avoided by judicious choice of electrolytes. For example, sodium perchlorate is much more soluble that potassium perchlorate, so sodium chloride is used in BASi silver/silver chloride reference electrodes rather than potassium chloride.
chloride has also been used as the reference electrode electrolyte; since it is soluble in both aqueous and non-aqueous media (such reference electrodes are not available commercially). The precipitation of electrolyte salts increases the reference electrode impedance and changes the liquid junction potential, which causes the reference potential to change with time. Therefore, prolonged exposure to organic solvents should typically be avoided, and the stability of the reference potential should be regularly checked (by using an internal reference or by comparing with another reference electrode). However, aqueous reference electrodes can be used for bulk electrolysis experiments in non-aqueous solvents, since a large overpotential is typically used and the small potential drift that occurs during the experiment should therefore have little effect (although the magnitude of the potential change should be checked after the experiment).

Another potentially serious problem that can occur is contamination of the sample solution by components of the reference electrode solution (e.g., water and chloride ions). For example, many organometallic compounds are highly reactive to water, and hence cannot be exposed to the small amounts of water that diffuse from the reference electrode during the experiment. One approach that has been used to overcome this has been the use of 'double-junction' reference electrodes, in which the aqueous reference electrode is isolated from the sample solution using a salt bridge containing a nonaqueous solvent/electrolyte system. However, this approach does not rigorously exclude water, so it is not appropriate for highly-water sensitive systems. In addition, there are disadvantages to this approach, as the introduction of the second junction not only alters the reference potential by the addition of another junction potential, it also increases the impedance of the reference electrode.

Another reference electrode modification that can be particularly appropriate for non-aqueous systems is the use of a Luggin capillary. This allows the tip of the reference electrode to be placed very close to the working electrode surface, thereby decreasing the uncompensated solution resistance (Ru) between the reference and working electrodes. However, exact placement of the Luggin probe is required in order to obtain reproducible resistance compensation; in addition, if the tip is too close, part of the electrode surface is blocked, which leads to non-uniform current distribution. The Luggin capillary also increases the reference electrode impedance.

There are two reference electrode systems that do not require water, and hence are suitable for nonaqueous electrochemistry of water-sensitive systems. These are the pseudo-reference electrode and the silver/silver ion electrode.

**Pseudo-Reference Electrodes**

Pseudo-reference electrodes are simply metal wires (e.g., platinum or silver) immersed in the sample solution. Although such electrodes do provide a constant potential, the reference potential is unknown, and is dependent on the composition of the sample solution. Consequently, redox potentials measured using a pseudo-reference electrode should be quoted relative to redox potential of the internal reference compound. One advantage of pseudo-reference electrodes is their low impedance.

**Silver/Silver Ion Electrode**

The redox process for this electrode is

\[ Ag^+ + e^- \leftrightarrow Ag \]
This electrode is less stable than the aqueous electrodes discussed above (due to diffusion of silver ions out of the electrode and the photoreactivity of these ions), and must be prepared frequently. BASi provides a non-aqueous reference electrode kit, which requires assembly by the user. The BASi nonaqueous reference electrode consists of a silver wire immersed in a solution of silver nitrate or perchlorate (0.001M to 0.01M) and electrolyte (e.g., 0.1M TBAP) in the desired organic solvent. Suitable organic solvents include acetonitrile, dimethylsulfoxide (DMSO), methanol, ethanol and tetrahydrofuran (THF). Silver ions are reduced by dimethylformamide (DMF) and are insoluble in methylene chloride; these solvents are therefore not suitable for this reference electrode (acetonitrile can be used as the reference electrode solvent when one of these other two solvents is used for the sample solution). The potential for the silver/silver ion reference electrode depends on the solvent, the silver ion concentration as well as the nature and concentration of the electrolyte. It is also changed by the introduction of salt bridges, which are used to decrease contamination of the sample solution by silver ions.

**Reference Electrode Impedance**

The impedance of the reference can have a significant effect on the current response of the cell. A high impedance reference electrode can not only slow the response of the potentiostat (slow rise time), it also increases the susceptibility of the system to environmental noise (particularly power line noise). There are a number of factors that can increase the impedance (see above), and the construction of the reference electrode can require careful consideration.

### 8.3. Troubleshooting

*Epsilon EClipse™ will not link with computer and following dialog box appears:*

1. Select **Reconnect Epsilon** under the **Instrument** menu.
2. Check that the Epsilon EClipse™ is turned on.
3. Check the USB cable between computer and Epsilon EClipse™.

**The Epsilon EClipse™ appears to have an electronics problem.**

Perform the following analog electronics test.

1. Open a **New Cyclic Voltammetry** experiment and set the parameters as shown below. The **Celle Selection** should be set to **Internal Dummy Cell 10kΩ**.
2. Run the experiment. The plot should be a sloping line going through 0 from -0.1 mA to 0.1 mA (as shown below). If the Epsilon EClipse™ passes this test, then the problem could be in the cell lead, but is more likely to be with the cell.
**All LED’s on front panel stay lit after power up.**

Call BASi service.

**Some techniques are marked demo.**

If some techniques are marked demo, then they have not been enabled in that particular Epsilon EClipse™ instrument. Contact BASi for price quote to add the additional techniques to the instrument.

**Fan Filter**

The Epsilon EClipse™ uses a cooling fan to prevent overheating. The fan has a filter which prevents dust from entering the instrument. As dust accumulates, the volume of airflow will decrease, thus reducing the cooling efficiency.

**CLEAN THE FAN FILTER EVERY THREE MONTHS, OR MORE OFTEN IF VISIBLY DIRTY.**

Clean the filter as follows:

1. Grip the fan filter retainer on both sides and gently pull off. If necessary, you can use a flat screwdriver (or other similar tool) to gently pry up the tabs on the top and sides of the filter retainer (see below).

2. Remove the filter from the retainer.

3. You may vacuum the filter or wash it in warm sudsy water. Be careful not to tear it.

4. If you’ve washed the filter, blot it well between sheets of paper towels, and then allow it to dry.

5. Reinstall the filter in the retainer. Hold both parts in place over the fan opening, then gently snap the four retaining clips in place.

Contact BASi if you need replacement parts.
Appendix A: EC FAQs

- Electrodes
- Electrolyte Solutions
- Voltammetry

Electrodes

- Most electrochemical cells I've seen have only 2 electrodes. Why do I need 3 electrodes for cyclic voltammetry and related techniques?
- What are the requirements for a working electrode material, and which material should I choose?
- Is there a difference between glassy carbon and pyrolytic graphite?
- Do I need to clean the surface of the working electrode between experiments, and, if so, how?
- What applications are mercury drop electrodes used for, and what special requirements are needed for such electrodes?
- What are the pros and cons of mercury drop electrodes and mercury film electrodes for stripping voltammetry?
- Does the size of my working electrode matter?
- What properties are required for a reference electrode?
- What are the differences between the silver/silver chloride reference electrode and the saturated calomel reference electrode?
- What are liquid junction potentials, and how do they affect measured potentials?
- What factors can affect the potential of a reference electrode?
- How do I store reference electrodes?
- Can I use aqueous reference electrodes for non-aqueous solutions?
- I need to use anhydrous electrolyte, so an aqueous reference electrode is not suitable. What are the alternatives?
- What are the requirements for the auxiliary electrode?
- Does the auxiliary electrode need to be isolated from the working electrode?

Most electrochemical cells I've seen have only 2 electrodes. Why do I need 3 electrodes for cyclic voltammetry and related techniques?

All electrochemical cells require at least two electrodes, since the potential of a given electrode can only be measured relative to another electrode, the potential of which must be constant (a reference electrode). In potentiometric measurements (such as measurement of pH), there is no current through the cell, and these two electrodes are sufficient (it should be noted that many pH and ion-selective electrodes used in potentiometric measurements are combination electrodes – both electrodes are contained within the same body). However, in a cyclic voltammetry experiment, an external potential is applied to the cell, and the current response is measured. Precise control of the external applied potential is required, but this is generally not possible with a two electrode system, due to the potential
drop across the cell due to the solution resistance (potential drop (E) = current (i) x solution resistance (R)) and the polarization of the counter electrode that is required to complete the current measuring circuit. Better potential control is achieved using a potentiostat and a three electrode system, in which the potential of one electrode (the working electrode) is controlled relative to the reference electrode, and the current passes between the working electrode and the third electrode (the auxiliary electrode).

What are the requirements for a working electrode material, and which material should I choose?

A working electrode acts as a source or sink of electrons for exchange with molecules in the interfacial region (the solution adjacent to the electrode surface), and must be an electronic conductor. It must also be electrochemically inert (i.e., does not generate a current in response to an applied potential) over a wide potential range (the potential window). Commonly used working electrode materials for cyclic voltammetry include platinum, gold, mercury, and glassy carbon. Other materials (e.g., semiconductors and other metals) are also used, for more specific applications. The choice of material depends upon the potential window required (e.g., mercury can only be used for negative potentials, due to oxidation of mercury at more positive potentials), as well as the rate of electron transfer (slow electron transfer kinetics can affect the reversibility of redox behavior of the system under study). The rate of electron transfer can vary considerably from one material to another, even for the same analyte, due to, for example, catalytic interactions between the analyte and active species on the electrode surface.

Is there a difference between glassy carbon and pyrolytic graphite?

Glassy carbon is an amorphous form of carbon, whereas pyrolytic graphite has a more ordered structure, with distinct planes - the basal plane and the edge plane. The edge plane is considerably more conducting than the basal plane. Glassy carbon is mechanically more durable than pyrolytic graphite.

Do I need to clean the surface of the working electrode between experiments, and, if so, how?

If material adsorbs to the surface of a working electrode, then the current response will degrade, and the electrode surface needs to be cleaned. Such adsorption occurs more readily for some analytes than for other, and hence the required cleaning frequency varies. In many cases, the only cleaning required is light polishing with a fine polish, such as 1 μm diamond, or 0.05 μm alumina. A few drops of polish are placed on a polishing pad (brown Texmet for alumina, and white nylon for diamond), and the electrode is held vertically and rubbed on the polish in a figure of eight pattern for 30 seconds to a few minutes (depending upon the condition of the electrode surface). After polishing, the electrode surface is rinsed thoroughly with water (for alumina) or methanol (for diamond), and allowed to air dry (electrodes polished with alumina may also need to be sonicated in distilled water for a few minutes to remove any residual alumina particles). The choice of polish depends upon the analyte and the electrode - use the polishing method that gives the best results (i.e., reproducible current response) for a given system. More pronounced surface defects (e.g., a scratch) may need to be polished with a more coarse polish. Once the defect has been removed, the electrode must then be polished with successively finer polish to obtain a mirror-like surface.

Electrochemical cleaning (applying large anodic or cathodic potentials to the electrode) has also been shown to be effective in some instances.
What applications are mercury drop electrodes used for, and what special requirement are needed for such electrodes?

Mercury drop electrodes have 3 major advantages over solid electrode materials such as platinum and glassy carbon:

a) a more reproducible surface
b) more negative potentials can be attained in aqueous systems
c) amalgamation with heavy metals (e.g., lead and cadmium)

Therefore, mercury drop electrodes are used for determination of trace metals using stripping voltammetry (where reproducibility is critical) and measurements at negative potentials in aqueous systems. Mercury drop electrodes consist of a mercury drop at the end of the capillary. The other end of the capillary is attached to a reservoir of mercury, and control of the flow of mercury from the reservoir is controlled by a valve. The simplest mercury electrode is the Dropping Mercury Electrode (DME), for which the valve is held open throughout the experiment. The mercury drop is therefore dynamic, growing to a certain size before falling of the capillary under its own weight (the drop can also be displaced at set time intervals using a drop knocker). An alternative mercury electrode is the Static Mercury Drop Electrode (SMDE), for which the valve is held open for a set length of time. The size of the mercury drop generated is constant once the valve is closed. The drop is displaced using a drop knocker. In the Controlled Growth Mercury Electrode (CGME), which is only available from BAS, the drop is grown incrementally, using a user-defined series of valve openings. The timing of the valve openings and drop knocks for the SMDE and CGME, and their coordination with changes in the applied potential and the current measurement require microprocessor control. An electrochemical experiment can use one mercury drop (a Hanging Mercury Drop Electrode – HMDE) (e.g., stripping experiments) or a series of mercury drops coordinated with potential pulses (e.g., pulse polarographic experiments).

What are the pros and cons of mercury drop electrodes and mercury film electrodes for stripping voltammetry?

Mercury film electrodes consist of a thin “film” of mercury deposited on an electrode surface (typically glassy carbon) by reduction of a mercury(II) salt in solution. It can be difficult to obtain a reproducible film, and this can affect the reproducibility of the results, particularly when compared to the reproducibility obtained using a mercury drop electrode. However, the surface area/volume ratio is larger for the mercury film electrode, and this electrode is more stable, which allows a faster stirring rate to be used in the deposition step. Both these factors decrease the deposition time required for the mercury film electrode. In addition, the resolution for adjacent peaks is better for the mercury film electrodes, due to sharper peaks.

Does the size of my working electrode matter?

The standard BAS working electrode for voltammetry is a disk with a diameter of 1.6 - 3 mm. Decreasing the size of the electrode to micron dimensions (microelectrodes) decreases the iR drop at the electrode, decreases the electrode capacitance (which allows a faster scan rate to be used for cyclic voltammetry), and changes the diffusion to the electrode surface from linear to radial.

What properties are required for a reference electrode?

The major requirement for a reference electrode is that the potential does not change with time. Since the passage of current through an electrode can alter the potential, such effects are minimized for the
reference electrode in the three electrode system by a) having a high input impedance for the reference electrode (thereby decreasing the current passing through the reference electrode to negligible levels) and b) using a non-polarizable electrode as the reference electrode (i.e., the passage of small currents does not alter the potential).

**What are the differences between the silver/silver chloride reference electrode and the saturated calomel reference electrode?**

These reference electrodes are similar, and consist of a redox reaction between a sparingly soluble chloride and the metallic element in an aqueous chloride solution. They can be used interchangeably, BUT it is extremely important to specify which is used, since their potentials are different (e.g., the potential of the BAS silver/silver chloride reference electrodes is -35 mV relative to the saturated calomel electrode). Since potential values are relative to the reference electrode, failure to specify the reference electrode makes any quoted potential values meaningless.

**What are liquid junction potentials, and how do they affect measured potentials?**

The salt solution required for a reference electrode must be separated from the analyte solution by a frit that allows ionic conduction between the two solutions, but does not allow appreciable contamination of the analyte solution by the reference electrode solution (or vice versa). In the BAS electrode, this frit is made of either a ceramic material (RE-4 and RE-6 electrodes for aqueous solutions) or of porous Vycor (RE-5 or RE-5B for either aqueous or non-aqueous solutions). Typically, the solutions separated by the frit do not contain the same ions, and the different rates of diffusion across the frit by the different ions gives rise to a potential across the frit – the junction potential. This is a further contribution to the potential between the working and reference electrodes. Since the junction potential is different for solutions of different ionic compositions, strictly speaking, redox potentials measured in different solutions (e.g., different organic solvents) cannot be compared directly, and an internal standard is required.

**What factors can affect the potential of a reference electrode?**

The potential of a reference electrode varies with temperature (typically 0.5 - 1.0 mV/°C). Therefore, precise measurement of redox potentials requires the use of a constant temperature bath for the cell. The potentials of the silver/silver chloride and calomel reference electrode are also affected by the concentration of chloride in the electrode solution, which must therefore be maintained at a constant value by proper storage.

**How do I store reference electrodes?**

Since the potential of a chloride-containing reference electrode is sensitive to chloride concentration, the electrode must be stored with the frit immersed in a solution that is identical in composition and concentration to the reference electrode solution (e.g., 3 M sodium chloride for the BAS silver/silver chloride reference electrode). Since this solution can corrode the electrode connectors, the electrodes must be stored in a appropriate storage vial that protects the connectors from the solution. When BAS reference electrodes are shipped, the frit is covered with yellow plastic to maintain electrode integrity during shipping. This plastic should be carefully removed upon receipt of the electrodes, which should then be stored in the appropriate solution. During shipping, air bubbles can become lodged at the inside of the Vycor tip. These must be dislodged (by flicking the end of the electrode) before the electrode can be used, otherwise artifacts (e.g., excessive noise) may be seen in the experimental data.
Can I use aqueous reference electrodes for non-aqueous solutions?

Aqueous reference electrodes can be used in non-aqueous solutions in many instances, but problems can arise. First, junction potentials can be quite large for non-aqueous solutions, so comparison of redox potentials between aqueous and non-aqueous solutions (and between different non-aqueous solutions) requires an internal standard. Second, salts from the electrolyte solutions can precipitate in the frit, leading to increased noise in the current response. For example, if a perchlorate salt is used in the analyte solution, and a potassium solution is used in the reference electrode, potassium perchlorate can precipitate in the frit. This problem is decreased in BAS reference electrodes by using sodium chloride in silver/silver chloride reference electrode, since sodium perchlorate is more soluble than potassium perchlorate. Third, since water and chloride ions can diffuse through the frit into the analyte solution (albeit slowly), aqueous reference electrodes are not suitable for water and chloride sensitive analytes.

I need to use anhydrous electrolyte, so an aqueous reference electrode is not suitable. What are the alternatives?

If contamination by water from aqueous electrodes is a problem, there are a number of alternatives. The simplest is to use a salt bridge containing the anhydrous electrolyte to separate the aqueous reference electrode from the analyte solution. Other alternatives include using a non-aqueous reference electrode or a pseudo-reference electrode. The BAS non-aqueous reference electrode (MF-2062) requires user assembly, and consists of a silver wire immersed in a solution containing silver nitrate (0.001 - 0.01 M) dissolved in a solution of an appropriate electrolyte. Ideally, this electrolyte is the same as that used for the analyte (to eliminate junction potentials), but not all organic solvents are suitable (acetonitrile, DMSO, methanol, ethanol, and THF are suitable, whereas DMF and chlorinated solvents are not). If the analyte electrolyte is not suitable, an acetonitrile-based electrolyte can be generally be used. The potential of the non-aqueous reference electrode depends on the solvent, the electrolyte, and the concentrations of silver nitrate and the salt. Since the potential of a non-aqueous reference electrode can vary among different electrodes, redox potentials measured using such a reference electrode should be quoted relative to an internal reference compound (e.g., ferrocene). A pseudo-reference electrode is simply a platinum or silver wire immersed in the analyte solution. This has the advantage that there can be no contamination of the analyte, but the disadvantage is that the reference potential is unknown, as it is dependent on the composition of the analyte solution. Therefore, redox potentials measured using a pseudo-reference electrode should again be quoted relative to an internal reference compound such as ferrocene.

What the requirements for the auxiliary electrode?

The auxiliary electrode is typically a platinum wire that provides a surface for a redox reaction to balance the one occurring at the surface of the working electrode, and does not need special care, such as polishing. In order to support the current generated at the working electrode, the surface area of the auxiliary electrode must be equal to or larger than that of the working electrode. Three auxiliary electrodes are available from BAS: two are straight platinum wires for use with stationary solution voltammetry experiments, and the other (MW-1033) is a longer platinum coil that is used for experiments that generate larger currents, such as rotating disk voltammetry and bulk electrolysis. One of the platinum wire electrodes (MW-4130) should be used with C1 Cell Stands, the VC-2 Cell (MF-1052), the Microcell (MF-1065), and the C2 Low Volume Cell (MF-2040), whereas the other (MW-1032) should be used with the C2 and C3 Cell Stands.
Does the auxiliary electrode need to be isolated from the working electrode?

During any electrochemical experiment, a redox reaction occurs at the surface of the auxiliary electrode (to balance the redox reaction at the surface of the working electrode), and the products of this reaction can diffuse to the working electrode and interfere with the redox reaction occurring at that site. However, in electroanalytical experiments such as cyclic voltammetry, the time scale of the experiment is too short for this diffusion to be able to cause significant interference, so there is no need to place the auxiliary electrode in a separate compartment. However, electrosynthetic (bulk electrolysis) experiments are typically much longer than electroanalytical experiments, so separation of the auxiliary electrode is required (see, e.g., the BAS bulk electrolysis cell (MF-1056)).

Electrolyte Solutions

- What medium is required for electrochemical experiment?
- What solvents and salts are appropriate for an electrolyte solution?
- What are some typical electrolyte solutions?
- How does solution resistance affect my experiments?
- What is a Luggin capillary?
- What is positive feedback iR compensation?
- How does uncompensated resistance affect a cyclic voltammogram?

What medium is required for electrochemical experiment?

The medium must be conducting. This can be achieved by using either a molten salt or an electrolyte solution. An electrolyte solution is made by adding an ionic salt to an appropriate solvent.

What solvents and salts are appropriate for an electrolyte solution?

The salt must become fully dissociated in the solvent in order to generate a conducting (i.e., ionic) solution. The electrolyte solution must also be able to dissolve the analyte, must be electrochemically inert over a wide potential range (i.e., no current due to electrolyte solution oxidation/reduction), and must be pure (e.g., the presence of water decreases the size of the potential range). It must also be chemically inert, so that it will not react with any reactive species generated in the experiment (e.g., acetonitrile is nucleophilic, so can react with electrogenerated cations). If the temperature is to be varied, the electrolyte solution must have an appropriate liquid range.

What are some typical electrolyte solutions?

Electrolyte solutions can be aqueous or non-aqueous. A wide range of salts can be used for aqueous electrolyte solutions. Since the redox potentials of some compounds are pH sensitive, buffered solutions should be used for these compounds. Suitable non-aqueous solvents include acetonitrile, DMF, DMSO, THF, methylene chloride, and propylene carbonate. Salts for non-aqueous electrolyte solutions typically consist of a large cation (e.g., tetraalkylammonium cations), and large anions (e.g., hexafluorophosphate, tetrafluoroborate, and perchlorate) to ensure full dissociation. N.B. Perchlorate salts must be handled with care, since they are potentially explosive.

How does solution resistance affect my experiments?

Although the addition of fully dissociated salts improves the conductivity of the electrolyte solution, many electrolyte solutions (particularly those based on non-aqueous solvents) have a significant resistance (hundreds of ohms). This leads to a potential drop between the electrodes (termed iR drop –...
potential = current (i) x solution resistance (R). Some of this iR drop can be compensated for by using a potentiostat and a three electrode system. However, some resistance (between the working and reference electrodes) remains uncompensated. This uncompensated resistance can be decreased or eliminated by careful cell design (including use of a Luggin capillary), positive feedback iR compensation, or post-run data correction.

**What is a Luggin capillary?**

Uncompensated resistance can be decreased by placing the reference electrode close to the surface of the working electrode. This can be achieved using a Luggin capillary, which is a hooked capillary that is attached to the end of the reference electrode (i.e., it is an extension to the reference electrode). The tip end of the capillary is placed close to the surface of the working electrode. However, it must not be placed too close, otherwise part of the surface may be blocked. In addition, exact placement of the capillary tip is required to obtain reproducible results.

**What is positive feedback iR compensation?**

Positive feedback iR compensation is available on the epsilon. This method feeds back a voltage into the cell electronics to compensate for the iR drop due to the solution resistance. However, care must be taken when selecting the applied feedback voltage, since too high a voltage can drive the electronics into oscillation, which can adversely affect the surface of the working electrode (since extreme potentials are applied). This is prevented in BASi instruments by first measuring the uncompensated solution resistance, and then increasing the magnitude of the feedback incrementally, testing the system for stability after each increment.

**How does uncompensated resistance affect a cyclic voltammogram?**

If the uncompensated resistance is significant (hundreds of ohms), then the peak potential separation increases and the peak current decreases. These effects become more pronounced with increasing scan rate. Unfortunately, these effects are also characteristic of slow electron transfer kinetics. Since slow electron transfer kinetics are not dependent on analyte concentration, and the effects of uncompensated resistance are (E = iR), the two can be differentiated by running the experiments at different analyte concentrations.

**Voltammetry**

- What is voltammetry?
- Why is there a current response to the applied potential?
- How are the energies of Fermi level and the frontier orbitals determined?
- Do all molecules have a measurable redox potential?
- What equipment is required for voltammetry experiments?
- Is the solution stirred?
- Do I need to deoxygenate the solution?

**What is voltammetry?**

In a voltammetric experiment, a potential is applied to a system (e.g., a transition metal complex in solution) using two electrodes (a working electrode and a reference electrode), and the current response is measured using the working electrode and a third electrode, the auxiliary electrode.
Why is there a current response to the applied potential?

The current arises from transfer of electrons between the energy levels of the working electrode and the molecular energy levels of the system under study. This current is often referred to as the faradaic current. Transfer of electrons from filled electrode orbitals to vacant molecular orbitals is referred as reduction, whereas transfer of electrons from filled molecular orbitals to vacant electrode orbitals is referred to as oxidation. Whether oxidation or reduction can occur depends upon the relative energies of the Fermi level of the electrode (i.e., the energy of the highest occupied electrode orbital) and the frontier molecular orbitals; for example, reduction can occur if the Fermi level is higher than the lowest unoccupied molecular orbital, whereas oxidation requires that the Fermi level is lower than the highest occupied molecular orbital.

How are the energies of Fermi level and the frontier orbitals determined?

The Fermi level is determined by the potential applied to the electrode; that is, varying the applied potential changes the oxidizing/reducing ability of the electrode. For example, more negative potentials increase the reducing ability of the electrode. In contrast, the energies of the molecular frontier orbitals are determined by the molecular structure and can be considered to be constant. Therefore, a common approach in voltammetry experiments is to vary the applied potential, and to record the potential at which a current response is detected; that is, the energy at which oxidation or reduction occurs. The redox potential is a measure of this energy.

Do all molecules have a measurable redox potential?

Although all molecules do have frontier orbitals, in practice these are not always accessible in a voltammetry experiment. Molecules for which a redox potential can be measured are referred to as electrochemically active. Examples of electrochemically active molecules include organic molecules with extended p-systems (e.g., aromatic molecules) and transition metal complexes. It should also be noted that some systems have the ability to undergo more than one oxidation or reduction, and hence have more than one redox potential.

What equipment is required for voltammetry experiments?

First, a potentiostat is required for controlling the applied potential, and a current-to-voltage converter is required for measuring the current. These are both contained within the epsilon. A user interface is required to define the way the potential is applied - the potential waveform. There are a number of different potential waveforms, and these are referred to by characteristic names; for example, cyclic voltammetry, and differential pulse voltammetry. These different potential waveforms (or techniques) are discussed in more detail in the appropriate section. The epsilon must be connected to the electrochemical cell. This contains the three electrodes immersed in an electrolyte solution of the molecule.

Is the solution stirred?

Stirring the solution has a significant effect on the current response, since it affects the rate at which electroactive molecules are brought from the bulk solution to the electrode surface (this process is referred to as mass transport). In many voltammetry experiments, there is no stirring, and the only form of mass transport is diffusion (this gives rise to the tailed peak shape observed in cyclic voltammetry). These are referred to as stationary solution techniques. In other experiments, the solution is stirred, either by a stir bar or a rotating electrode (the latter is preferable, due to the more precise control of the rate of rotation). These are referred to as hydrodynamic techniques.
Do I need to deoxygenate the solution?

Oxygen is electroactive, and can be reduced quite easily. Therefore, it must be removed from the solution if the system under study is reducible. Oxygen is typically removed by bubbling an inert gas (e.g., nitrogen or argon) through the solution for about 10 minutes. If a stationary solution experiment is to be performed, it is important that the stirring is stopped and the solution is allowed to become quiescent before the experiment is started (although a blanketing layer of inert gas over the solution can be maintained during the experiment.

Appendix B: iR Compensation

In any potentiostatic experiment, it is assumed that the potential drop across the interfacial region at the working electrode is the same as the potential applied between the reference and working electrode. However, this is not true, since there is some iR drop between these two electrodes due to solution resistance. This resistance can be lowered by addition of supporting electrolyte, and in many cases does not need to be considered. However, there are instances where it is detrimental to the experiment; in these cases, it can be compensated for electronically. This is achieved on the Epsilon EClipse™ using positive feedback iR compensation.

One problem with positive feedback iR compensation is determining the amount of compensation to use, since too much feedback can drive the electronics into oscillation, which can have a deleterious effect on both the electronics and the electrodes. The automatic iR compensation option on the Epsilon EClipse™ prevents this by first measuring the uncompensated solution resistance, followed by incremental compensation and circuit stability testing. These features are described below.

Measurement of Uncompensated Resistance

In this measurement, the electrochemical cell is considered to be electronically equivalent to the RC circuit shown above; that is, the uncompensated resistance (R_U) is in series with the double-layer capacitance (C_dl). Since a faradaic impedance is not conserved as part of this model, the test potential must be at a value at which no faradaic process occurs. A potential step is applied at this potential and the current is sampled at set points after the step is applied. The current decays exponentially (see graph below), and the initial current (I_0) is calculated by extrapolating back to zero time. Since E = I_0R_U, R_U can be calculated from this measurement. To reduce any error, this measurement is performed multiple times, and the results averaged.
Compensation and Circuit Stability Testing

Compensation is achieved by positive feedback into the potentiostat. However, problems due to circuit instability can arise, even when the degree of compensation is significantly less than 100%. Therefore, the amount of positive feedback is increased incrementally, and the stability of the circuit is tested after each increment. The amount of positive feedback is increased until the (user-specified) % value is obtained (default = 100%), or the system does not pass the stability test.

In the stability test, the current following a potential step at the Test potential is again measured. As the percent compensation increases, the current response initially shows a “ringing effect”, which is a precursor to oscillation (see figure above), and is followed by exponential decay. The degree of pre-oscillation ringing can quantitated by a term defined as overshoot, which is the ratio of a minimum (net negative) current value ($I_{\text{min}}$) to a maximum current value ($I_{\text{max}}$) expressed as a percentage: that is, overshoot $= \left(\frac{I_{\text{min}}}{I_{\text{max}}}\right) \times 100$. The maximum allowable percentage overshoot is defined by the user (default = 20%). If the percentage overshoot value measured by the stability test is less than the maximum allowable value, then compensation is increased. If it is greater, and the desired level of compensation has not yet been achieved, a capacitor is inserted between the reference and auxiliary electrodes to stabilize the circuit, and the testing is continued until the desired level of compensation is achieved or the percentage overshoot value is exceeded (if this occurs, the amount of compensation to be used in the experiment is slightly decreased from this value). One way to increase the level of compensation is to increase the overshoot percentage. It is usually safe to go up to 40%.
If the desired compensation cannot be obtained using automatic iR Compensation, then a user-specified compensation resistance can be applied. If this option is used, then a stabilizing capacitor may also need to be selected manually.

Appendix C: CV Analysis

The asymmetric shape of the current-voltage plot of a CV or an LSV experiment (a cyclic or linear sweep voltammogram, respectively) can be rationalized by considering the concentration profiles at different time points for O and R for the reduction reaction O + e⁻ = R.
Concentration profiles for cyclic voltammetry for a simple reduction reaction. Simulation by DigiSim ®

At the start of the experiment, the bulk solution contains only O, so at potentials well positive of the redox potentials, there is no net conversion of O to R (a). As the redox potential is approached, there is a net cathodic current which increases exponentially with potential due to the exponential potential dependence of the rate of heterogeneous electron transfer. As O is converted to R, concentration gradients are set up for both O and R, and diffusion occurs down these gradients (O diffuses towards the electrode, and R diffuses in the opposite direction). The redox potential is at b, and the surface concentrations of O and R are equal at this potential. After the (cathodic) peak potential (c), the current decays as a result of the depletion of O in the interfacial region. The rate of electrolysis (and hence the current) now depends on the rate of mass transport of O from the bulk solution to the electrode surface; that is, it is dependent on the rate of diffusion of O, so the time dependence is $t^{-1/2}$. The peak is therefore asymmetric. Upon reversal of the direction of the potential scan (in a CV experiment), the current continues to decay with $t^{-1/2}$ until the potential nears the redox potential, at which point there begins a net re-oxidation of R to O which causes an anodic current. However, some R molecules have diffused away from the electrode surface, and so have to diffuse back to the electrode before they can be re-oxidized. Therefore, the current does not decay to zero following the re-oxidation (anodic) peak.
on the reverse scan (h). The important parameters for a linear sweep or cyclic voltammogram (see images below) are the peak potential(s) $E_p$ and the peak current(s) $i_p$ (note that there can be more than one peak in a cyclic voltammogram; hence an additional subscript ($\text{a} = \text{anodic}$, $\text{c} = \text{cathodic}$) is often used).

A typical linear sweep voltammogram showing the important parameters

A typical cyclic voltammogram showing the important parameters

If a redox system remains in equilibrium throughout the potential scan, the redox process is said to be reversible (equilibrium requires that the surface concentrations of $O$ and $R$ are maintained at the values
required by the Nernst equation). The following parameter values are used to characterize the cyclic voltammogram of a reversible process:

- The peak potential separation \( \Delta E_p = (E_{pc} - E_{pa}) = 59.2/n \) mV at all scan rates at 25°C
- The peak current ratio \( i_{pa}/i_{pc} = 1 \) at all scan rates
- The peak current function \( i_p/\nu^{3/2} (\nu = \text{scan rate}) \) is independent of \( \nu \) (see equation for peak current)

The peak current is given by the equation:

\[
i_p = 2.69 \times 10^5 n^{3/2} AC\nu^{1/2}
\]

where:
- \( n \) = number of electrons transferred/molecule
- \( A \) = electrode surface area (cm\(^2\))
- \( C \) = concentration (mol cm\(^{-3}\))
- \( D \) = diffusion coefficient (cm\(^2\) s\(^{-1}\))

For a reversible process, \( E^{O'} \) is given by the mean of the peak potentials.

Departures from reversible behavior for a redox process are shown by variations of the above parameters from the values observed for reversible processes. There are two major causes for irreversible behavior and these are discussed below.

**Slow Electron Transfer Kinetics**

Reversibility requires that the electron transfer kinetics are fast enough to maintain the surface concentrations of O and R at the values required by the Nernst equation. Hence, reversibility depends on the relative values of the standard heterogeneous electron transfer rate constant \( (k_s) \) and the rate of change of potential - the scan rate \( \nu \). If the ratio of \( k_s/\nu \) is sufficiently small that Nernstian concentrations cannot be maintained, then the process is said to be quasi-reversible. A quasi-reversible process is characterized by \( \Delta E_p > 59.2/n \) mV, with the value increasing with increasing \( \nu \).

Since reversibility depends on the value of \( k_s/\nu \), it may be possible to change a process from quasi-reversible to reversible by decreasing \( \nu \) (which allows more time for the surface concentrations to adjust to the new values required by the changing potential). In addition, \( \Delta E_p \) depends on the value of \( k_s/\nu \) and \( k_s \) can therefore be calculated from the variation of \( \Delta E_p \) with \( \nu \).

Unfortunately, increases in \( \Delta E_p \) with increasing \( n \) can also be due to uncompensated solution resistance \( R_u \). The effect of \( R_u \) can be minimized by careful experimental design, electronic positive feedback compensation and post-run data manipulation. The two effects can be distinguished by varying the analyte concentration (the potential drop due to uncompensated solution resistance, and hence the resulting \( \Delta E_p \), increase with increasing current, whereas \( k_s \) is independent of analyte concentration).

**Chemical Reactions of O and R**

Equilibrium values of O and R can only be maintained during a cyclic voltammery experiment if both O and R are stable on the experimental time scale. For example, if the reduction of O to R is followed by the conversion of R to P, then more R must be generated to compensate for the loss of R. Therefore, the rate of reduction increases and \( E_{pc} \) moves to a more positive value. In addition, \( i_{pa}/i_{pc} \) is less than unity (since only a fraction of the molecules that were reduced on the forward scan are available for
The value of the current function can also be affected by chemical reactions following electron transfer.

The effect of a chemical reaction depends on the value of the ratio k/v (where k is the rate of the chemical reaction). If this value is large, then the chemical reaction has a significant effect, whereas any effect is much less if this ratio is small. Therefore, it may be possible to eliminate the effect of the chemical reaction (thereby restoring reversibility) by increasing v. k can be calculated either by simulation studies or by investigating the effect of v on i_{pa}/i_{pc}.

Although cyclic voltammetry is very widely used for the initial redox characterization of a molecule (i.e., the redox potentials, and the stability of the different oxidations states) and for qualitative investigation of chemical reactions that accompany electron transfer, there are a number of disadvantages inherent in this technique:

a. The effects of slow heterogeneous electron transfer and chemical reactions cannot be separated. If both of these effects are present, then the rate constants for these processes can only be calculated using simulation methods.

b. There is a background charging current throughout the experiment of magnitude vC_{dl} (where C_{dl} is the capacitance of the interface at the working electrode). This restricts the detection limit to about 10^{-5} M. In addition, the ratio of the peak faradaic current to the charging current decreases with increasing v (since \(i_p\) is proportional to \(v^{1/2}\)), and this places an upper limit on the value of n that can be used.

In spite of these limitations, cyclic voltammetry is very well suited for a wide range of applications. Indeed, in some areas of research, cyclic voltammetry is one of the standard techniques used for characterization.

**Derived Graphs**

The default plot for LSV and CV is the current vs. potential plot. However, two other plots are available: SemiIntegration and SemiDifferentiation (see images below). These are mathematical transforms of the basic current vs. potential plot.
Appendix D: CA Analysis

Let us consider the effect of a single potential step on the reaction $R = O + e^-$. At potentials significantly more negative than the redox potential ($E_{nr}$), there is no net conversion of $R$ to $O$, whereas at potentials significantly more positive than the redox potential ($E_d$), the rate of the reaction is diffusion-controlled (i.e. molecules of $R$ are electrolyzed as soon as they arrive at the electrode surface). In most potential step experiments, $E_{nr}$ is the Initial Potential, and $E_d$ is the First Step Potential. The advantage of using these two potentials is that any effects of slow heterogeneous electron transfer kinetics are eliminated. In double potential step experiments, ($E_{nr}$) is often used as the Second Step Potential.
Concentration profiles for a single potential step experiment. Simulation by DigiSim®

It is instructive to consider the concentration profiles of O and R following the potential step. Initially, only R is present in solution (a). After the potential step, the concentration of R at the electrode surface decreases to zero, and hence a concentration gradient is set up between the interfacial region and the bulk solution (b). As molecules of R diffuse down this concentration gradient to the electrode surface (and are converted to O), a diffusion layer (i.e. a region of the solution in which the concentration of R has been depleted) is formed. The width of this layer increases with increasing time (b-d). There is also a net diffusion of O molecules away from the electrode surface.

Since the current is directly proportional to the rate of electrolysis, the current response to a potential step is a current 'spike' (due to initial electrolysis of species at the electrode surface) followed by time-dependent decay (due to diffusion of molecules to the electrode surface). See the image below.

*Current-time response for a double-potential step chronoamperometry experiment*
For a diffusion-controlled current, the current-time (i-t) curve is described by the Cottrell equation:

\[ i = nFACD^{1/2}\pi^{-1/2}t^{-1/2} \]

where:
- \( n \) = number of electrons transferred/molecule
- \( F \) = Faraday’s constant (96,500 C mol\(^{-1}\))
- \( A \) = electrode area (cm\(^2\))
- \( D \) = diffusion coefficient (cm\(^2\) s\(^{-1}\))
- \( C \) = concentration (mol cm\(^{-3}\))

This indicates that, under these conditions, there is a linear relationship between the current and the \( 1/\sqrt{t} \). A plot of \( i \) vs. \( t^{1/2} \) is often referred to as the Cottrell plot.

**Cottrell plot for a chronoamperometry experiment**

The analysis of chronocoulometry (CC) data is based on the Anson equation, which defines the charge-time dependence for linear diffusion control:

\[ Q = 2nFACD^{1/2}\pi^{-1/2}t^{1/2} \]

The charge-time (Q-t) (the Anson equation) is obtained by integrating the Cottrell equation with respect to time. A typical charge-time plot is shown below:

**Charge-time response for a double-potential step chronocoulometry/chronoamperometry experiment**
Charge is the integral of current, so the response for CC increases with time, whereas that for CA decreases. Since the latter parts of the signal response must be used for data analysis (the finite rise time of the potentiostat invalidates the early time points), the larger signal response at the latter parts for CC makes this the more favorable potential step technique for many applications (in addition, integration decreases the noise level).

Anson plot for a chronocoulometry experiment

The slope and intercept of the Cottrell and Anson plots can be measured by the Epsilon EClipse™ software. Since the slope of the Cottrell and Anson plots are determined by $n$, $A$, $D$, and $C$, one of these parameters can be calculated from the slope, provided the other three are known. One application of CA and CC is the determination of either $D$ or $A$.

It is important to note that in any potential step experiment, there is a delay in attaining the step potential due to the finite rise time of the potentiostat. This non-ideal behavior affects the validity of the data points measured during this delay time, and hence these data are discarded when calculating the slope and intercept (the default condition for the Epsilon EClipse™ software is that the final 80% of data points are used). The non-linearity of the early data points is most clearly shown in the Cottrell plot, due to the reciprocal time function (i.e., early data points = large x). In contrast, the non-linearity is much less pronounced in the Anson plot.

Double potential step techniques can be used to investigate the kinetics of chemical reactions following electron transfer. As discussed elsewhere, only a fraction of the molecules of O that are formed as a result of the first potential step are reduced again during the second step. Therefore, the current or charge due to the second step ($i_r$ or $Q_r$) is less than that due to the first step ($i_f$ or $Q_f$). If O undergoes a chemical reaction to a molecule that is not reduced after the second step, then even fewer molecules of O are available for reduction, and $i_r$ and $Q_r$ show a corresponding decrease. The rate of the chemical reaction ($k$) can be calculated by investigating the effect of changing the Step Time on the $i_r/i_f$ (or $Q_r/Q_f$) ratio and comparing these values to published working curves. Although working curves are available for both $i_r/i_f$ and $Q_r/Q_f$, CC is generally more favored due to the better signal to noise ratio.

One of the major applications of CC is the study of species adsorbed to the surface of the working electrode (indeed, it was originally devised for such studies). The advantage of using CC rather than CA is that it is possible to separate the charge due to the electrolysis of the adsorbed molecules from the charge due to the electrolysis of molecules in solution and the double layer charge (the analogous separation of currents is generally not possible). This is achieved using the Anson plot.
As discussed above, the electrolysis of solution species is diffusion-controlled, and depends on $t^{1/2}$. In contrast, the electrolysis of adsorbed species is essentially instantaneously, as is the double layer charging. The equation for the total charge $Q$ is:

$$Q = Q_{\text{diff}} + Q_{\text{ads}} + Q_{\text{dl}} \quad \text{or} \quad Q = 2nFACD^{1/2} \pi^{-1/2} t^{1/2} + nFA\Gamma_0 + Q_{\text{dl}}$$

where:
- $Q_{\text{diff}}$ = charge due to electrolysis of solution species
- $Q_{\text{ads}}$ = charge due to electrolysis of adsorbed species
- $Q_{\text{dl}}$ = double-layer charging
- $\Gamma_0$ = surface concentration of adsorbed species (mol cm$^{-2}$)

Therefore, the intercept of the Anson plot is the sum of $Q_{\text{dl}}$ and $Q_{\text{ads}}$. One method for eliminating $Q_{\text{dl}}$ from the equation is to run the identical experiment on the electrolyte alone. However, this approach assumes that $Q_{\text{dl}}$ is the same both in the presence and in the absence of the adsorbed analyte, which is generally not a valid assumption. The alternative method is to use the double potential step experiment. If only one of O and R adsorbs, then $Q_{\text{ads}}$ is the difference of the intercepts of the Anson plots for the two steps.

It is important to note that data from the later time domains of the experiment are being used to investigate behavior that occurred at early time points. This shows that integration retains information about electrolysis that occurs essentially simultaneously with the potential step. This is a major advantage of CC, since direct measurement of such behavior is generally very difficult.

In all the above applications, the initial potential is at a value at which electrolysis does not occur, and the step potential is at a value at which electrolysis occurs at a diffusion-controlled rate (the second step is generally from the step potential back to the initial potential). Therefore, before these potentials can be determined, the redox potential must first be known. In general, the simplest way to find these potentials is to record the cyclic voltammogram of the analyte.

**Appendix E: CPE Analysis**

The potential required for a CPE experiment is determined by the redox potential of the analyte (measured by, for example, cyclic voltammetry). For a reduction, the ideal potential is ca. 200 mV more negative than the redox potential so that the rate of electrolysis is controlled by the rate of mass transport to the working electrode. However, it is not always possible to use a potential too far removed from the redox potential due to electrolysis of other electroactive materials (i.e. electrolyte, solvent, or other components of the solution mixture).

The cell required for CPE is significantly different to that required for voltammetry experiments (in which only a very small fraction of the electroactive molecule of interest is electrolyzed). The rate of electrolysis is enhanced by using a working electrode with a large surface area (i.e. platinum gauze, reticulated vitreous carbon or a mercury pool) and an auxiliary electrode with a large surface area (i.e. platinum coil or gauze); in addition, the solution is stirred to increase the rate of mass transport to and from the working electrode. The auxiliary electrode must be isolated from the working electrode to prevent species that are electrogenerated at the auxiliary electrode from interfering with electrolysis at the working electrode. However, care must be taken when choosing the material used to isolate the auxiliary electrode from the working electrode, since high resistance material may affect the efficiency of the electrolysis.
The output from a CPE experiment is a current vs. time plot (a typical example is shown below).

\[ Q = nFN \]
where: \( n \) = number of electrons transferred/molecule  
\( F \) = Faraday’s constant (96,500 C mol\(^{-1}\))  
\( N \) = amount of material electrolyzed (mol)

**Appendix F: CP Analysis**

The shape of the potential response can be rationalized by considering the concentration profiles of the redox species as a function of time:

Let us consider the electron transfer reaction \( O + e^- = R \). Before the current step, the concentration of \( O \) at the electrode surface is the same as in the bulk solution (i.e. 5 mM). The initial potential is the rest potential or the open circuit potential (\( E_{o.c.} \)). Once the (reducing) current step has been applied, \( O \) is reduced to \( R \) at the electrode surface in order to support the applied current, and the concentration of \( O \) at the electrode surface therefore decreases. This sets up a concentration gradient for \( O \) between the bulk solution and the electrode surface, and molecules of \( O \) diffuse down this concentration gradient to the electrode surface. The potential is close to the redox potential for \( O + e^- = R \), and its precise value depends upon the Nernst equation:

\[
E = E^{0'} + \frac{0.059}{n} \log \frac{C_O^S}{C_R^S}
\]

where \( C_O^S \) and \( C_R^S \) are the surface concentrations of \( O \) and \( R \), respectively. These concentrations vary with time, so the potential also varies with time, which is reflected in the finite slope of the potential vs. time plot at this stage. Once the concentration of \( O \) at the electrode surface is zero, the applied current can no longer be supported by this electron transfer reaction, so the potential changes to the redox potential of another electron transfer reaction. If no other analyte has been added to the solution, the second electron transfer reaction will involve reduction of the electrolyte; that is, there is a large change in the potential.
Typical potential response for a chronopotentiometry experiment